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Windows has improved so much 
over the years, but there are still 
little things that can get in the 
way of enjoying your time on 
your PC. Whether it’s constant 
pop-up messages or hardware 
not behaving itself properly, 
these minor annoyances can 
often stop you doing the things 
you need to do. 

This issue we want to get rid 
of as many of these bugbears 
as we can. To kick things off, 
on page 16, we have 100 great 
tips for Windows 10 that will 

show you plenty of the hidden 
settings. We also have a great 
feature on preparing a repair disc 
(page 68), for those times when 
something goes really wrong, and 
don’t forget our regular Support 
Squad feature (page 74) for 
answers to your PC questions. 

Add to that our usual mix of 
creative tutorials, software 
roundups and hardware 
reviews, and you’ve got a 
really great read to kick 
off this new year! See 
you again on 3 February.  

Welcome

SUBSCRIBE TO THE MAG TODAY  
AND SAVE – JUST TURN TO PAGE 30!

We pride ourselves in being the only 
magazine on the shelves to show you  
exactly how to get the very best from
the Windows operating system, whether 
you’re using Windows 10 or Windows  
8.1. Also, don’t forget to take a look at  
how you can read the magazine on your 
laptop, phone or tablet.
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34 Stop your pC from  
crashing using Event Viewer

38 Make better voice recordings 
with the audacity app

42 Have fun with your photos  
for free with pixlr Express

44 use the same mouse and 
keyboard across multiple pCs

48 use your apps from any  
pC online with Cameyo

52 play DVDs, video and  
audio files using VLC

54 Run apps without affecting  
the rest of your system

58 Solve eight major  
Windows 10 annoyances

60 avoid distractions while  
using your computer

Your guide Graham Barlow says…

“If you’re looking for better ways to use your home 
computer, then this is the place to start. We’ll show 
you all the tips and tricks the experts use and more!”

ExpLORE  
The best PC tutorials
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The Knowledge…

Mesh networks are the biggest thing  
to happen to home networking since  
Wi-Fi was first introduced in the late 90s, 
and Google is getting into the game  
early. Google Wifi consists of a router  
and satellite modules to place around  
your home to eliminate networking black 
spots – near thick walls, for instance, or  
on each floor. Currently on sale in the  
US, Google Wifi should hit the UK in the 
next few months.

Learn how to program 
your PC the easy way

Get into coding today

 F
ancy trying your hand as a 
programmer? It’s not nearly as 
intimidating as it might seem. If 
you’re starting from scratch, you 

should start with, er, Scratch. 
It’s a visual language developed by 

the computer wizards at MIT, specifically 
designed to help kids aged 6-16 learn 
coding concepts. That said, it’s equally 
valuable for older minds, although its 
output is limited to simple animations 
or games. You 
don’t even need 
to download 
anything – just head 
on over to http://
scratch.mit.edu, click 
the ‘Create’ button in the header, and you’ll 
find yourself straight into the interface. 

Scratch includes many integrated 
tutorials that, in theory, can teach anyone 
how to use its drag-and-drop modules 
to learn the fundamentals of coding, and 
it’s all written in plain, straightforward 
English. Complete the course, or just read 
through some of the pre-built programs, 
and you’ll soon know all about the world of 

loops, variables, and other previously 
baffling programming essentials. 

A grounding in Scratch, admittedly, 
doesn’t include every little skill required 
for the real world of type-it-yourself 
coding, but the next step up costs 
nothing but time and a little dedication. 
First and foremost, Microsoft’s Visual 
Studio – software that’s perfect for 
writing code, organising it and eventually 
build it into a fully-functioning Windows 10 

application – is free.
The very latest  

2017 Release 
Candidate is currently 
available from www.
visualstudio.com. 

With that in place, it’s probably time  
to learn a proper language. Microsoft’s 
Virtual Academy, in conjunction with  
Bob Tabor of Developer Academy, offers  
a 24-part video series explaining the  
basics of C# for absolute beginners –  
http://bit.ly/29kYqVt – and a similar  
course for developing full Windows 10 
apps at http://bit.ly/2gDdbqd. What will 
you create?

becoming a Windows coder has never been more 
straightforward – even your kids can do it

Minecraft:  
Education Edition
What’s this?
It’s a special edition of kid-favourite 
block-construction game Minecraft, 
specifically tailored for use in classrooms, 
introduced by Microsoft following its 
purchase of the game’s publisher, Mojang.

Games? In the classroom?
Don’t be too disgusted. What could 
possibly delight a child more than 
being allowed to play their favourite 
game at school, sharing a virtual world 
with all their friends? Not an awful lot. 
And Minecraft is the perfect game for 
the purpose.

What makes it so suitable?
While there are indeed zombies and 
skeletons to contend with in the endless 
world of Minecraft, that’s a small part of 
the game. It’s built around a huge number 
of elements that teachers can use to 
emphasise learning topics: artistry, 
construction, exploration, experimentation 
and collaboration are at its core, and 
setting lessons inside a game is a great 
way to engage the sleepy kids at the back.

What else does it do?
Older children will be able to learn basic 
programming in-game, adding life to their 
architecture – perhaps creating deadly 
mazes for their friends to traverse – using 
the game’s command block system. It’s 
even possible to take your first steps in 
electronic engineering with Minecraft, 
drawing paths with its electrically 
conductive redstone material that closely 
resemble real-world circuitry.

How can I try it?
You’ll need an Office 365 education 
account to get hold of the specially 
discounted Education Edition for 
your students – find out more at  
http://education.minecraft.net – but if 
you’re not an educator, you’ll need to 
plump for the full version. It’s missing a 
few of the more school-centric features, 
like an in-game progress journal and a 
classroom tour guide, but it’s well worth 
its £17.95 asking price.

Control It a simple app helps you manage your 
mesh network and all of your connected devices

CIrCulatE It Putting your devices this close 
together isn’t going to get you very far

ConCEal It Each individual unit is small and 
inconspicuous enough to tuck away on a shelf

GooGLE GoEs Wi-Fi Google while you Google

if you’re starting from 
scratch, you should start 

with scratch

Discover
Learn to code
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 T
he UK internet market is somewhat 
divided. There are the those who 
live close to a telephone exchange, 
or who are lucky enough to have 

fibre-optic cables in their street. These folk 
enjoy fast internet speeds from some of the 
best broadband connections in Europe. 
Then there are the 
huge number of 
people who fall outside 
that coverage area, 
limping along with 
sub-par broadband or 
even, in the cases of 
some rural areas, dusty 
dial-up connections or 
super-expensive 
satellite internet. 
Getting a better 
connection installed 
can be difficult, and 
whatever your data rate, you’re likely to be 
paying through the nose for it.

The UK’s communication regulator, 
Ofcom, is aware of this. After reviewing the 
practices of BT and its broadband 
infrastructure-owning subsidiary Openreach, 
it has now demanded that the two 
companies operate more separately over 
concerns that BT was favouring its own 
business interests over the provision of 
quality broadband for the country’s internet 

users. What does this mean for you? Perhaps, 
at this stage, not an awful lot – Ofcom has 
stopped short of enforcing a full split 
between the companies, merely demanding 
at this stage that they maintain independent 
management structures – but it’s definite 
pressure, which could both excite potential 

competitors and entice 
BT to up provision and 
drop prices to prevent 
any further meddling.

For those with poor 
connections, there’s 
some bad news: we 
may be some way from 
UK-wide cabled 
broadband 
connectivity – 
Openreach currently 
charges £30 per metre 
of buried cable, 

making connecting rural villages too 
expensive for most councils. Improvements 
to existing lines should happen slightly 
faster, however, so expect the UK’s average 
speed to go up. And if you’re struggling to 
pay the bills, check out www.cable.co.uk, on 
Ofcom-approved broadband price 
comparison site, which should give you an 
idea of your options. Send a message: don’t 
be afraid to divorce your current provider if 
you can get a better deal elsewhere.

Government body steps in to look at quality of service

Everyone’s talking about...

1What is Microsoft’s 

VR headset called?

A. HoloLens
B. VirtuaLens
C. HoloGoggles

2Which phone 
company did 

Microsoft buy in 2014?

A. Motorola
B. Nokia
C. Ericsson

3What year was 
Microsoft founded?

A. 1981
B. 1983
C. 1975

4What was Microsoft’s 

first product?
A. Microsoft BASIC
B. Microsoft DOS
C. Microsoft Windows

5Who co-founded 
Microsoft with  

Bill Gates?
A. Steve Ballmer
B. Paul Allen
C. Satya Nadella

6Which of these 
started off as  

part of Microsoft?
A. Expedia
B. Ticketmaster
C. Google

Pens at the ready, your time starts now!The 60-Second Quiz

Answers 1: A, 2: B, 3: C, 4: A, 5: B, 6: A

Will there be better 
broadband for Britain?

Humble Bundle
www.humblebundle.com

If you’re a fan of books, comics, games and 
other digital entertainment, you can get 
these things for a hugely discounted price 
from the good folk at Humble. Not only do 
they run a store with money off the latest 
games, they run a series of concurrent 
bundles – packs of products available on a 
choose-your-own price basis for a limited 
time. You get to choose where your cash 
goes – whether it’s to the content creators, 
to Humble itself, to charity, or to a mix of 
the three. Recent bundles have included a 
huge pack of coding books, a massive 
archive of Doctor Who comics, and an 
absurd $30, 50-game bundle (with all 
proceeds going to charity) from the 
video-creating folks at the Yogscast. The 
transient and secretive nature of these 
things means we can’t tell you what’ll be 
there when you read this – you’ll have to 
visit and find out for yourself...

Cheap triCks Line the shelves of your 
digital library with many a bundle

Discover
Better broadband
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Graham Barlow reveals a host  
of fascinating digital facts

£31 
million

The amount owed by 
YouTube in unclaimed 

music royalties for 
music uploaded by its 

users in the US 
between August 2012 
and December 2015. 

The money will be paid 
out by YouTube 

following an agreement 
with the US National 

Music Publishers’ 
Association (NMPA).

is the amount recommended to 
safely charge the original Samsung 
Note 7 battery. A new update aims 
to encourage the few owners who 
have not yet returned the faulty 
devices to hand them in. Samsung 
issued a global recall for the Galaxy 
Note 7 in September after batteries 
seemed to explode. 

The growth in London’s 'gig 
economy' (transport and storage) 
since 2010, thanks to apps such as 
Deliveroo and Uber. The number 
employed had risen from about 
38,000 in 2010 to about 65,300 in 
2016. Typically, workers use 
mobile phone apps to identify 
people who require delivery 
services or small practical jobs.

72% 

 is the number of installs since the launch of a brand-new plug-in for 
Facebook, known as 'BS Detector', which flags up "questionable" websites on 
Facebook and Twitter. It was created by Daniel Sieradski "in about an hour" 
as a "rejoinder to Mark Zuckerberg's dubious claims that Facebook is unable 
to substantively address the proliferation of fake news on its platform".
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The hottest new Windows hardware on the horizon
Incoming

Oakley 
 Radar Pace 

£400 uk.oakley.com

The Radar Pace are smart shades indeed – they 
come with voice control, fitness sensors and a 
virtual trainer. A collaboration between Oakley, 
Intel and design specialist Luxottica, the glasses 
offer real-time, voice-activated coaching during 
workouts. Integrated motion, humidity and 
proximity sensors are used to track movement, 
and you can pair the glasses with external devices 
to monitor metrics, such as heart rate. The Radar  
Pace will adjust your training zones as you  
improve and automatically make up for missed 
workouts, helping you stay on track and hit your 
fitness goals. 

During a run you can ask, “OK Radar, how’s  
my pace?” and it will tell you how you’re doing and 
whether you need to speed up or slow down. The 
sunglasses are IPX5-rated for water resistance, too, 
and are built to withstand impacts. 



14  |    |  February 2017

Surface Studio
We go hands-on with Microsoft's all-in-one PC

icrosoft has been all 
about setting 
hardware standards. 
It's done it for 2-in-1 
laptops with the 

Surface Pro 4, and now it seems to 
have set the bar for all-in-one PCs 
with the Surface Studio.

Just as the rumours and leaks 
foretold, the Surface Studio is  
a 28-inch all-in-one PC with a  
new iteration on Microsoft's 
PixelSense display, and an all-new 
way to control the device in the 
Surface Dial.

display, a 6th-gen Intel Core i5 
processor, 8GB of RAM and a 2GB 
Nvidia GeForce GTX 965M GPU. 

If you need more power for your 
day-to-day routine, however, you 
can upgrade to an i7 configuration 
with 16GB of RAM or an i7 with 
32GB of RAM and a 4GB GTX 980M 
GPU from about $2,999 or $3,499, 
respectively. While a Surface Pen 
comes standard with every Surface 
Studio purchase, early pre-orders 
included a Surface Dial accessory 
free of charge.

As of right now, however, orders 
are slated to ship in ‘early 2017’, with 
every machine coming with a Surface 
Keyboard, Surface Mouse and 
Windows 10 Pro pre-installed, and 
the Surface Dial available for extra.

Inside and out 
Microsoft touted on stage that, at 
12.5mm at its thickest point, the 
Surface Studio is the thinnest 
desktop monitor ever created. The 
word 'monitor' is key there, as there's 
no PC hardware within the screen 
unit, as with most all-in-one PCs.

Nay, Microsoft shoved all of that 
stuff – the processor, the 

graphics, the 

What the rumours and leaks 
didn't prepare us for, however, was 
the price: around $2,999 (although 
pricing is yet to be confirmed).

How does the Surface Studio 
justify that astronomical price tag? 
By being a very strong contender 
for the title of 'Best All-In-One PC Of 
All Time', that's how.

Release date and price
You can pre-order the Surface 
Studio right now. It doesn’t come 
cheap, but for that price you’ll get 
an adjustable, 28-inch PixelSense 

M

The Surface Studio is a  
great canvas for artists.

A great machine 
that adapts to your 
creative needs.

The game-changing 
Surface Dial.

>> Preview 
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Preview 
Surface Studio

memory and the hard drive – into 
the tiny base that holds the 'zero-
gravity hinge'. This hinge absorbs all 
of the torque required to move the 
13-pound display, making it 
amazingly easy to switch between 
its standard desktop PC orientation 
and that of a big drawing surface.

Using the device in its 20-degree-
angled drawing orientation feels 
wonderful, even for someone who 
isn't a digital artist by any stretch. It's 
like having the most powerful 
Wacom tablet in the world, which 
just so happens to be a complete 
computer running Windows 10 Pro.

The components inside allow for a 
seamless drawing experience, in 
that your taps, swipes and other 
stylus gestures are rendered so near 
1:1 that it seems as instantaneous as 
creating physical art.

Those components include up to 
a quad-core Intel Core i7-6820HQ 
processor at 2.7GHz, Nvidia's GTX 
980M graphics chip with 4GB of 
memory, as much as 32GB of RAM 

and a hybrid hard drive as large as 
2TB (128GB SSD). 

All of this sits in the Mac Mini-like 
puck in the base, which in turn 
powers the 4500 x 3000 
touchscreen at 192 pixels per inch.

Now, you might balk at the 
graphics chip from last year, and 
Microsoft hasn't had much to say 
about why this device doesn't 
include a 10-series Nvidia chip  
with the latest Pascal architecture. 
Our best guess is that Microsoft 
started work on this way before 
Pascal was even a thing, and got the 
power it wanted out of the old-hat 
graphics processor. 

Likewise, it's also running an 
older-generation Intel mobile 
processor, due to there not being 
any high-end Kaby Lake processors 
available yet. 

All in all, the Studio feels like the 
most premium all-in-one we've ever 
laid hands on.

Surface Dial
One of the most interesting bits 
about the Surface Studio isn't the 
all-in-one at all, but its brand-new 
accessory, the Surface Dial. This  
is a radial control module that 
operates over Bluetooth, just like  
the included Surface Keyboard and 
Surface Mouse. 

But, unless you're pre-ordering a 
Surface Studio immediately as of 

this writing, you'll have to drum 
up extra to take advantage of it – 
here's why you might want to do 
just that.

The Dial offers specific controls in 
certain Windows apps, like the 
upcoming Paint3D, allowing for 
quick access to controls that you'd 
otherwise have to stop drawing to 
use. For instance, in Bing Maps, you 
can use the Dial to zoom and tilt a 
3D map image.

 In an app such as Paint3D, you 
can access colour swatches and 
pen or brush styles by simply 
long-pressing the Dial. Then, you 
just turn the dial to your desired 
selection, and press in once. 

Better yet, the Dial can interact 
with the Surface Studio screen to 
make its radial options around the 
device when it's placed anywhere 
on the screen's surface. Imagine 
drawing something with the 
Surface Pen in your right hand and 
immediately changing the colour 
of your input with the Dial in your 
left hand. It's a marvel to watch, 
much less try yourself.

Of course, the Surface Dial is one 
of those accessories that only 
digital artists and other creative 
professionals are going to get the 
most out of. But that's who the 
Surface Studio is aimed at anyway: 
digital artists that are sick of using 
separate surfaces to create on. ■

Mouse and 
keyboard are part 
of the package.

Get the job done with 
all the efficiency of 
your desktop PC.
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Whether you’ve been 
using Windows for 
years or you are a 

newcomer to the PC, there’s 
always something new to learn 
– especially as Microsoft puts 
out frequent, free updates to 
improve, and occasionally 
completely change, the way its 
operating system works. There 
are plenty of hidden tricks in 
Windows 10’s Anniversary 
Update that will make your 
day-to-day computing life that 
little bit easier.

Some tools and options are 
easy to discover, but there are 
numerous other secrets that you 

can reveal by scratching beneath 
the surface of your PC.

Over the coming pages, we’ll 
share some of the best Windows 
advice, including simple hints 
such as manipulating your 
Taskbar items, or locking your 
computer, to more complex 
tasks such as clearing storage 
space or creating an emergency 
boot disk.

These tips are written for the 
latest release of Windows 10, but 
many will work with earlier 
versions too, as features are 
carried through the generations. 
So read on for a wealth of 
information on Windows 10.

We reveal 100 essential hints, tips and secrets  
for getting more out of Windows 10
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23re-order  
the Taskbar

Inject some order into the Taskbar by 
moving taskbar icons. Just click and drag 
one to its new place – you’ll see the other 
icons move to make way.

22
Burn ISo  
disc images
Just right-click an ISO file on your 
machine and select the ‘Burn disc 
image’ option. Select the disc burner 
you’d like to use, insert a blank disc 
and click the ‘Burn’ button.

18  |    |  February 2017

02Use pinned folders  
for really fast access

If you use the same folders often, pinned 
folders come in handy. To pin a folder to 
Windows Explorer’s jump list, open File 
Explorer, then drag a folder into the Quick 
Access list – not only will it be visible from 
here, when you right-click the File Explorer 
Taskbar icon you’ll find the pinned folder 
is there too.

03 Launch a new  
program window

When a program is running and you click 
its Taskbar icon you’ll switch to that app. 
If you’d prefer to launch a new window, 
just hold down the [Shift] key as you click 
the icon.

04Activate Dark Mode
If you’re a night owl or someone 

for whom a bright screen puts 

unnecessary strain on your eyes, press 
[Win]+[I] to open ‘Settings’, then head to 
‘Personalisation > Colours > App Mode’ 
and select ‘Dark’ to switch Windows’ 
colours to darker hues.

05Preview program 
Windows

With more than one instance of a program 
running you may not be able to tell which 
one you want to switch to next. To make 
things a little easier, hover the mouse over 
a program’s Taskbar button to display a 
preview of any currently running program. 
Move the mouse over one of the previews 
and you’ll be able to peek at a full-screen 
preview, then click to switch.

06 Lock with a key press
Stepping away from your 

computer for a few minutes? Keep it safe by 
pressing [Win]+[L] to lock it. It’s that simple!

07 Scroll inactive windows 
Windows 10 makes it possible to 

scroll windows that aren’t active – just roll 
your mouse over the window, then use 
your wheel to scroll without clicking to 
select the window. Switch this feature off 
via ‘Settings > Devices > Mouse & 
touchpad’ if it annoys you.

08Compatibility mode
Some older software that you rely 

on may not work as you expect under 
Windows 10. Try right-clicking the shortcut 
of a program, select ‘Properties > 
Compatibility’ tab. Tick the box in the 
‘Compatibility Mode’ section and select the 
version of Windows it worked with.

09Taskbar buttons  
on your terms

Windows saves space by combining 
windows from the same app into one 
Taskbar icon. Prefer to see each window 
individually? Right-click the Taskbar, select 
‘Properties’ and use the ‘Taskbar buttons’ 
dropdown menu to choose between the 
‘Always combine, hide labels’ and ‘Never 
combine’ options. 

10Calculate and convert
The calculator is capable of much 

more than adding and subtracting – click the 
menu button and you’ll find scientific and 
programmer options, a date calculator and 
various unit conversions too.

11Change window sizes  
with a shortcut

There are lots of ways you can change the 
size and position of an open window. Hold 
[Win] and press the up arrow to maximise a 
window or the down arrow to minimise it.  
You can also use [Win] in conjunction with 
the left and right arrow keys to snap the 
currently selected window to the left or 
right-hand side of the screen. Quickly tidy 
things up by pressing [Win]+[Home] to 
minimise everything except the current 
window, too.

01Run two programs  
side by side

Don’t bother manually resizing 
program windows, just drag a window 
to the left side of the screen and it will 
expand to fill half of it. Repeat with 
another window to the right to see 
both side by side. Windows can be 
undocked by dragging them out of 
position again. 
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100 power tips

24Quickly launch  
Taskbar apps 

You don’t need to use the mouse to launch 
programs that have shortcuts in the 
Taskbar. Press [Win]+[1] to launch the first 
icon on the Taskbar, and so on.

25 Quickly check  
the desktop

No need to minimise all your open windows 
to view the desktop – just move the mouse 
to the lower right-hand corner of the screen 
and they’ll  temporarily vanish!

26Close apps without 
switching to them 

Just hover the mouse cursor over a Taskbar 
button and click the red cross located on 
the upper-right of a preview to close it 
completely. Simple!
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12Make a bigger Start
By switching on ‘Show more tiles’ 

within the Start pane of the Taskbar screen 
in ‘Settings’, it’s now possible to maximise 
the Start menu to squeeze in more Live 
Tiles. Additionally, Live Tiles now take you 
directly to the content that is being 
displayed in the tiles – rather than the app’s 
‘home’ screen.

13Quickly rearrange the 
notification area

If you don’t like how icons are ordered in 
the notification area of the Taskbar, they 
can be simply dragged and dropped into 
new positions. Perfect for tailoring the 
Taskbar to suit your needs.

14 Free up disk space
To keep your hard drive running 

well, it’s a good idea to clear out the clutter. 
Type cleanmgr into the Search bar to 
quickly launch Windows’ own Disk Cleanup 
tool or download CCleaner from piriform.
com for a more powerful cleaning app.

15Minimise all  
windows at once

To quickly minimise all of your open 
programs and windows, press the 
[Win]+[M] key combo at the same time. 
Alternatively, grab a window with your 
mouse and shake it. This gesture will 
minimise all other windows, but leave the  
shaken one alone.

16Preview your fonts
Open the ‘Fonts’ folder from the 

Control Panel and you can preview the 
fonts you have installed without even 
having to open anything. Any you don’t 
need can be hidden or deleted – we 
recommend backing these up first by 
copying them to another folder.

17 Select files  
more easily

When you need to select multiple files, it 
can be quicker and easier if you use check 

boxes. Open File Explorer and switch to the 
‘View’ tab. Tick the ‘Item check boxes’ box 
and when you roll your mouse over a folder 
or file you’ll see a checkbox appear – tick 
this to select the file, then repeat for all the 
others you wish to select.

19 Edge extensions
Edge has introduced extensions, 

which add to its functionality and let you 
use the web more efficiently. You’ll find 
the usual suspects from competing 
browsers have already jumped on 
board – including the likes of AdBlock 

18ClearType still  
looks amazing

ClearType ensures text looks great on 
screen, but it can be fine-tuned to suit. 
Click ‘Start’ and type cttune to access the 
ClearType Text Tuner and you’ll be guided 
through the process. 

and Save to Pocket – in addition other 
entries, such as OneNote Web Clipper. 

20Avoid the Registry 
Want to tweak Windows settings 

without getting your hands dirty? 
Download and run Ultimate Windows 
Tweaker 4 from bit.ly/uwt-win10 where 
you’ll find loads of handy tweaks and 
customisation settings that require a single 
click to apply. Set a Restore Point before 
you begin.

21Give network locations 
their own drive letter

If you have a frequently accessed network 
folder, why not assign it a drive letter? 
Navigate to the network location in 
Explorer, right-click it and select ‘Map 
network drive’ and then choose a letter.
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33 Restore classic looks
If you don’t like the way items 

are displayed in the Notification area 
of the Taskbar (battery, time and date 
display, and volume control – we’re 
looking at you) then you can restore 
the old look. Fire up Ultimate 
Windows Tweaker. Go to 
‘Customization > Windows 10’ tab 
where you’ll find the options.

30View clocks from  
other time zones

The Taskbar shows you the current 
time, and it can also be used to check 
the time in up to two other countries. 
Go to ‘Date and time settings’ in 
Settings. Scroll down and click ‘Add 
clocks for different time zones’. Tick 
‘Show this clock’ and use the drop-
down menu to configure it.

34Cycling backwards
The Classic task switcher 

([Alt]+[Tab]) still remains – tap it to 
cycle forwards through the list of 
windows. Hold [Shift] as well as [Alt] 
and [Tab], and you can cycle 
backwards too.

31 Take control of UAC
User Account Control is a great, 

and very longstanding Windows 
security feature, and you can adjust 
just how sensitive it is to suit your 
preferences. Simply click the Start 
button, type uac and press [Enter]. You 
can then use the slider to choose when 
warnings should appear on your 
Windows 10 desktop.

35 Disable hibernation, 
free up space

Windows’ hibernation file takes up a 
lot of space, particularly on machines 
with lots of RAM. Disable it to recover 
the space by right-clicking the ‘Start’ 
button and choosing ‘Command  
Prompt (Admin)’. Type powercfg -h off 
and hit [Enter].

32Personalised  
display calibration 

If you like to be in complete control 
over how your display is calibrated, 
simply type dccw into the Search bar 
to access the Display Color Calibration 
Wizard. To proceed, click ‘Next’ and the 
wizard will help you to choose the best 
display settings.

29On-screen keyboard
If you’re having trouble with 

your keyboard and need to buy a new 
one, there’s a clever on-screen one you 
can use in the meantime. Type the 
command osk into the Cortana Search 
bar and press [Enter] to bring it up.

27 Quick and easy 
command prompt

Hold [Shift] while right-clicking a folder 
and you’ll reveal the previously hidden 
‘Open command window here’ option. 
This option will take you to that 
location on your machine in the 
command prompt window.

28 Show all your drives
If you’d like to see all drive 

letters at all times, including those 
with no media in them, click Options 
under the File Explorer ribbon’s View 
tab. Select this dialog’s View tab, 
untick the box labelled ‘Hide empty 
drives’ and then click OK. You’ll now 
see all your PC’s drives.



36 Run as administrator
You can run any program in the 

Taskbar in the role of an administrator by 
simply holding down the keys [Ctrl]+[Shift] 
at the same time.

37Cycle through a single app
We all know that [Alt]+[Tab] is a 

handy shortcut for cycling through 
programs. If you want to cycle through just 
one program’s open documents or 
windows, hold down the [Ctrl] button and 
click its Taskbar icon until you access the 
window you’re looking for.

38Open Explorer  
at This PC

Open File Explorer and it’ll default to the 
Quick Access folder. If you’d rather it went to 
your drives instead, select ‘Options’ under the 
‘View’ tab and choose ‘This PC’ from the 
window that pops up.

39Control AutoPlay
Click ‘Start > Settings > Devices > 

AutoPlay’ and you can take control of what 
happens when you insert a disc or plug in an 
external drive. You can opt to disable 
AutoPlay completely as well.

40 Leave yourself a note
There’s no need to clutter your 

desk with a hundred different paper notes 
and reminders – you can leave electronic 
reminders on your desktop, instead. To do 
this, launch the Sticky Notes tool from the 
Start menu and create notes as and when 
you might need them. You can even 
right-click notes to customise their colour. 
This simple feature is a great way to help 
them to stand out.

46Restore libraries
Libraries are hidden by default in 

Windows 10 – bring them back by 
switching to the ‘View’ tab of File 
Explorer, then click the ‘Navigation pane’ 
button and pick ‘Show libraries’.

42 Activate windows  
without clicking

Want to bring your windows into focus 
simply by rolling the mouse over them? 
Type ease of access into the Search bar, 
then choose ‘Ease of Access Centre’. Click 
the link labelled ‘Make the mouse easier to 
use’ and then select the option labelled 
‘Activate a window by hovering over it with 
the mouse’ in the ‘Make it easier to manage 
windows’ section.

43 Gain more  
desktop space

The Taskbar is useful, but you may not need it 
on display at all times. To maximise the size of 
your desktop, right click an empty section of 
the Taskbar and select ‘Properties’. On the 
Taskbar tab, tick the box labelled ‘Auto-hide 
the Taskbar’ and click ‘OK.’ The Taskbar will 
disappear until you move your mouse to the 
very bottom of the screen – it will then slide 
into view.

44 Move windows between  
your monitors

If you’ve got more than one monitor 
connected to your computer, you can avoid 
having to drag and drop windows between 
screens by simply pressing the keyboard 

combo [Win]+[Shift] along with the left or 
right arrow keys.

45Task switching and  
virtual desktops

Windows 10 introduces a brand new Task 
Switcher – press [Win]+[Tab] keys together 
and you’ll see all open windows shrink to fit 
on-screen. Either click one to switch to it,  
or drag it to Desktop 2 at the bottom of the 
screen to transfer it to another (virtual) 
desktop. You can organise your windows 
over multiple desktops (click ‘+’ to create 
new ones) by dragging them to the desired 
desktop. Hold [Ctrl]+[Win] and hit the left 
and right arrow keys to move between your 
Windows 10 desktops.

41Fine-tune your 
hybrid tablet/pC

If you’ve bought a two-in-one tablet/
laptop device and you’re frustrated by 
Windows switching automatically 
between tablet and laptop mode when 
you undock your keyboard, simply 
open Notification Centre and tap 
‘Tablet Mode’ to switch manually. Click 
‘Start > Settings’ and browse to ‘System 
> Tablet mode’ to tweak related 
settings, such as leaving the Taskbar on-
screen at all times, even in Tablet mode.



59 Take screenshots
The Snipping Tool is the perfect 

way to capture an image of what’s 
happening on your desktop – handy for 
screenshots and troubleshooting.

48Get more from  
your large monitor

Massive monitors with super-high 
resolutions can make on-screen text too 
small to read easily. Adjust this via ‘Start > 
Settings > System > Display’ – use the 
‘Change the size of text, apps and other 
items’ slider to  push things up. Click 
‘Advanced Settings’ to access another 
dialog box from where you can control 
specific items.

49 Send To more places
The Send To section of the context 

menu is very useful. If you hold down 
[Shift] while right-clicking a file or folder, 
you’ll see an expanded list of options in the 
sub-menu that then appears. To delete or 
add locations for the Send To menu just hit 
[Win]+[R] and type: shell:sendto and then 
hit [Enter].

50 Record any of the 
problems you experience

There may be times when you run into a 
problem with your computer and you don’t 
know how to remedy it. It can be difficult to 
explain what’s going wrong to someone 
else, and this is where Problem Steps 
Recorder can help – it makes it possible to 
record what happens on screen and send it 
to someone who might be able to help. 
Typr psr into the Search bar and choose 
‘Steps Recorder’. Click the ‘Start Record’ 
button and use your computer until the 
problem you have been experiencing 
occurs again. Click ‘Stop Record’ before 
saving and emailing the file. 

51 See how your PC  
is being used

Windows 10’s Resource Monitor enables 
you to see how your processor, memory 

and hard drive are being used. Press 
[Win]+[R] type resmon and press [Enter]. 
The graphs reveal how individual programs 
and processes are making use of your 
computer’s hardware.

53Repair a problematic PC
Problems can arise from time to 

time and you may wish to reboot into one 
of Windows’ troubleshooting modes. To do 
this manually, hold [Shift] as you click ‘Start 
> Power > Restart’ to boot into the 
Advanced Start-up screen. You’ll find a 
number of options here  – to get into Safe 
mode, for example, select ‘Troubleshoot > 
Advanced Options > Start-up Settings > 
Restart’, then select your chosen mode – ‘4’ 
for Safe mode on its own, or ‘5’ for Safe 
mode with internet access – to boot into it.

54Pin Edge tabs
One of Edge’s simple yet really 

smart features is ‘pinning’ tabs to save 
space on the tabs bar. Right click an open 
tab and select ‘Pin’ to do it, and repeat the 
action (selecting ‘unpin’) to expand the 
tab again. 

55 Save Office files 
in WordPad

It might seem like a rather simple tool at 
first glance, but the WordPad program has 
more capabilities than you might think. If 
you click the ‘File’ option, followed by ‘Save 
As’, you’ll find that you’re able to save in the 
DOCX format without additional software 
– great for quick edits.

47 Side-screen Taskbar 
 If you’d prefer to make better 

use of the width of your widescreen 
monitor, why not move the Taskbar to 
the left or right rather than the 
bottom of the screen? This is a great 
way to reapproach the way you use 
your desktop. Right-click an empty 
section of the Taskbar and make sure 
that the ‘Lock the taskbar option’ 
does not have a tick next to it (if it 
does, just click it to remove it). You 
can then drag and drop the Taskbar 
to your preferred position before 
locking it in place again. Give it a try!

52Create your  
own shortcuts 

Create your own custom keyboard 
shortcuts to launch your favourite 
programs. Right-click a program 
shortcut and pick ‘Properties > 
Shortcut tab’, select the ‘Shortcut key’ 
field and press the keyboard combo 
you’d like to use before clicking the 
‘OK’ button.

58
project your 
desktop
Built-in support for projectors makes 
connecting your laptop to a 
projector simple. Simply open 
Notifications, click ‘Expand’ near the 
bottom, then select ‘Project’.

22  |    |  February 2017



Windows 10 
100 power tips

57 Play music on 
another computer 

Windows Media Player can be used to play local 
or network music files, but you can also push 
music to play on another computer as well. You 
need to set this up in advance, so launch 
Windows Media Player, click the ‘Stream’ button 
and then select ‘Turn on media streaming’. In the 
window that appears next, click the ‘Turn on 
media streaming’ button. Back in Windows 
Media Player, click the ‘Stream’ button again and 
then select ‘Allow remote control of my player > 
Allow remote control on this network’. Next, 
select ‘Stream’, followed by ‘Automatically allow 
devices to play my media’ – repeat on other 
computers on your network. Then right-click a 
music file and select ‘Cast to Device’ before 
selecting a PC or other device for playback.

60Check pC performance
You can manually run the Windows 

Experience Index tests in Windows 10 by 
installing the WEI Tool from winaero.com/ 
download.php?view.79

61 where’s the old  
Action Centre?

Type action into the Search box and click 
‘Security and Maintenance’ to find 
notifications of problems and fixit tools.

62Check your  
memory usage 

To see which programs are using up your 
memory, right-click the Taskbar and select 
‘Task Manager’, then click ‘More Details’.

56 Log on automatically 
Get to work faster. Press 

[Win]+[R], type netplwiz and press 
[Enter]. Untick the box labelled ‘Users 
must enter a user name and password 
to use this computer’, select your 
account before clicking ‘Apply’ and 
entering your password when 
prompted. Click ‘OK’ and you’re done!
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74Quickly close window
When looking at a Taskbar preview 

of a program or window, just click the 
middle mouse button to close the window 
without having to switch to it.

64Old-style Taskbar  
context menus

When you right-click a button in the 
Taskbar you gain access to jump lists. If 
you’d prefer to see options to maximise, 
minimise and close windows instead, hold 
down [Shift] while you right-click the 
Taskbar button.

65Restore Windows  
Photo Viewer 

You’ll either love or hate Windows 10’s 
new Photos app. If you hate it, this 
following tweak allows you to restore the 
classic Windows Photo Viewer app as the 
default: open Ultimate Windows Tweaker 
again, switch to the ‘Additional’ section 
and click ‘Enable Windows Photo Viewer’. 

Once done, make it the default for 
viewing photos once again under 
‘Settings > System > Default apps’.

66View a slideshow  
on your desktop

Can’t decide which picture to use as your 
background? There’s no need to settle for 
just one image when you could use a 
rotating slideshow instead. Right-click the 
desktop and select the ‘Personalise’ 
option. Click the ‘Background’ drop-down 
menu and choose ‘Slideshow’. You’ll be 
prompted to select a folder containing 
the images you wish to include – do so 
and decide how frequently the image will 
change. This is great for keeping the 
boring old desktop fresh and interesting.

68Get more Taskbar
Conversely, you might want to 

have a larger Taskbar so you can see more 
buttons or extra running programs. 
Right-click the Taskbar and make sure that 
the ‘Lock the taskbar’ option is not ticked. 
You can then drag the top of the Taskbar 
upwards to make it even taller, too.

69Play your music  
through Cortana

Cortana now allows you to play music on 
the lock screen before you’ve signed in by 
speaking commands, which is cool, 
particularly if you’re trying to run a headless 
media PC or similar. However, that 
integration with Microsoft’s services goes 
deeper: you need a Groove Music 
subscription for it to work.

70Desktop tidying
If you have icons scattered 

everywhere, just right-click the desktop 
and choose ‘View > Auto arrange icons’ to 
keep them in order.

63Get more  
screen space

You can see more of the 
desktop and your running 
programs by simply shrinking 
your Taskbar buttons. 
Right-click the Taskbar and 
select ‘Settings’ – on the 
Taskbar tab, tick the box 
labelled ‘Use small taskbar 
buttons’ to shrink them.

67Keep browsing  
in private

You can keep your browsing history 
private in the Edge browser by 
switching to InPrivate mode. You can 
do this by pressing the combo 
[Ctrl]+[Shift]+[P]. 

73
Favourite 
commands
Make your favourite ribbon 
commands more accessible in any 
supported app by right-clicking the 
option and choosing ‘Add to Quick 
Access Toolbar’.
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72Move your apps  
to a new drive 

If you’re running out of space on your hard drive – or 
have a Windows tablet with limited onboard storage – 
then navigate to ‘Settings > System > Storage’ and scroll 
down to the ‘Save locations’ section. Click the drop-
down menu under ‘New apps will save to’ and select 
another drive with more space. You can also move some 
existing Windows Store apps too if space is tight – switch 
to ‘Apps & features’, then click the app you’d like to 
transfer. If ‘Move’ isn’t greyed out, click it, select your 
destination and click ‘Move’ again to transfer that too.

75Jump to search
When you want to search for a file 

within a particular folder, simply press [F3] 
to jump to the search box, enter your 
chosen search term and hit the [Enter] key.

76Zoom in and out
To get a better view of what’s 

happening on your desktop, or in a 
program, press [Win]+[+] to zoom in. Use 
[Win]+[-] to zoom out again.

77Arrange your window
Right-click the Taskbar and click 

either ‘Show windows stacked’ or ‘Show 
windows side by side’. You can right-click 
again to access the undo option, too.

71Tweak your Quick  
Access settings

The Quick Access area in File Explorer 
now juggles frequently and recently 
accessed folders with pinned folders 
of your choosing. Switch to the ‘View’ 
tab and click ‘Options’ to choose 
whether or not to display recent files 
and frequent folders here. 
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78

79View all  
notification icons

Windows will save space by hiding 
some icons from the notification area. 
To see them at all times, click ‘Start > 
Settings > System > Notifications & 
actions’ and click ‘Select which icons 
appear on the taskbar. Make sure you 
flick the switch labelled ‘Always show 
all icons and notifications on the 
taskbar’ to ‘On’.

80Undo that  
unintentional move!

If you accidentally move, copy or send 
a file to the Recycle Bin on your 
desktop, you can then press [Ctrl]+[Z] 
to reverse the mistake. Phew!

81Check your  
energy efficiency

Right-click the Start button and choose 
‘Command Prompt (Admin)’. Type 
powercfg -energy and press [Enter]. 
After about a minute or so of loading 
navigate to the folder you’re told 
about (typically C:\Windows\System32) 
and open up the file energy-report.
html. This will show you what to do to 
improve energy efficiency.

reduce  
system sounds 
for calls
To prevent the music you’re 
listening to interfering with 
computer-based phone calls, you 
can opt to automatically have the 
volume level of system sounds 
reduced when a call is underway. 
Right-click the speaker icon in the 
notification area and select the 
‘Sounds’ option. Move to the 
‘Communications’ tab and select one 
of the three options to reduce 
volume or completely mute sounds.

82Make individual 
Settings accessible

Got a favourite tweak you frequently 
find yourself burrowing into Settings 
to find? You can create one-click 
shortcuts to them a number of 
different ways. The simplest thing to 
do is pin it as a tile to the Start menu 
simply by locating it in ‘Settings’, then 
right-clicking its entry in the left-hand 
pane and choosing ‘Pin to Start’.

83Choose your 
shutdown options

The power button can be used to do 
many things – Restart, Shutdown, 
Sleep, etc – and you can choose what 
should happen by default. Right-click 
the ‘Start’ button and select ‘Power 
options’, then click ‘Choose what the 
power buttons do’ to access the 
relevant options.

84Add tabs to  
File Explorer

File Explorer in Windows 10 is an 
improvement on Windows 7, but it’s 
still lacking in one key area – no 
tabbed support to prevent you 
cluttering up the desktop with 
multiple windows. Clover 3 is a free 
extension that adds Chrome-like tabs 
to File Explorer – go to www.ejie.me 
to get this free app.
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86

87pin saved 
searches to  

the Start menu 
File Explorer’s search tool is 
powerful – for example, you 
can set up a search to reveal 
all recently modified Word 
documents in a folder from 
that location: just type 
type:word 
datemodified:this week 
into Search. Click ‘Save 
search’ to add it to your 
Searches folder, then go 
there, right-click the search 
and choose ‘Pin to Start’.

85 Undelete  
your files

It’s easy to forget just how 
handy the Recycle Bin folder 
is. If you’ve deleted a file, 
document or folder that  
you need back, just open up 
the Recycle Bin from the 
desktop and you’ll find  
your files are still there ready 
to be restored.

Type the name of a file or folder 
into the Cortana search box and 
you’ll get a load of irrelevant 
results – click ‘My stuff’ to 
search your computer’s hard 

drive and other storage, 
including your OneDrive folder, 
for your missing files. Use the 
‘Show’ drop-down menu to 
filter results. 

Search with Cortana

Click the ‘Start’ button followed by 
the ‘Account’ button above ‘Settings’ 
and you’ll see some handy extra 
options: lock, sign out and switch 
user, plus access the ‘Change 
account settings’ screen.

Account 
shortcuts



Right-click the ‘Start’ button or press [Win]+[X] and 
you’ll open up a hidden Start menu. It provides a 
number of convenient shortcuts to powerful tools, 
including various Control Panel applets, Device 
Manager and the Command Prompt. Add your own, 
or rearrange and delete existing shortcuts courtesy of 
the [Win]+[X] Menu Editor. Download the app from 
http://winaero.com/download.php?view.21 where 
you’ll find it’s easy to add handy presets like Control 
Panel applets and administrative tools as well as 
custom shortcuts.
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95Use encryption  
with your drives

If you’re running Windows 
10 Pro, type bitlocker into 
the Search bar to switch on 
Bitlocker drive encryption; if 
not, download the free 
Veracrypt app from https://
veracrypt.codeplex.com.

93 Launch a website 
from the Taskbar

Sometimes it can be too 
much trouble to switch from 
the program you are working 
in, move to a browser and 
place the cursor in the 
address bar before typing a 
URL. Instead, simply type the 
web address you want to visit 
into the Cortana search bar 
and it’ll go straight there in 
your default web browser.

Create a USB boot drive

Make good use of the 
Quick Access menu

91All settings  
in one place

It’s something that has been 
dubbed as Windows 10’s ‘God 
Mode’, but in reality it is just a 
fantastically handy way to 
access a massive range of 
system options all in one 
place. Create a new folder and 
type the name xxx.
{ED7BA470-8E54-465E-825C-
99712043E01C}. You can 
change the ‘xxx’  
to anything you like, and 
when you open up the folder, 
you’ll be presented with a 
massive list of Control  
Panel options to work  
with, including tweaks not 
found in the newer Settings 
app. Just don’t go too mad 
with your new found power as 
you don’t want to have to 
resort to system recovery!

90Monitor the  
children

While parents want to let 
their child use a computer, they 
also want to ensure their kids 
are kept safe. Go to ‘Start > 
Settings > Accounts > Family & 
other users’ to set up user 
accounts for your children that 
you can configure to protect 
them while online plus manage 
their computer usage and 
monitor what they do.

89 Talk to your PC
If you can’t type very 

quickly or just fancy trying out 
something a little nifty on your 
new machine, type speech 
into the Search box and select 
‘Windows Speech Recognition’. 
Here you’ll find everything you 
need to configure your PC for 
voice activated control – it’s 
great for dictation, too.

It’s good to be prepared and 
this is where a recovery drive 
comes into play. Type 
recovery into the Search bar 
and choose ‘Create a 
recovery drive’. If you already 
have a Windows installation 
disc, untick ‘Back up system 

files to the recovery drive’ to 
save space before clicking 
‘Next’, then select a USB flash 
drive to create the drive on. If 
necessary, boot from this 
drive to access Windows 
repair options when 
Windows itself won’t boot.
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Final thoughts…
The Anniversary Update to Windows 10 
introduces some great new features, but 
it’s easy to remain trapped in a rut, 
sticking with what you know, even when 
there are better and often more efficient 
ways of doing things in Windows. We’ve 
covered a wide range of topics and 

features in this tips extravaganza, but 
there’s plenty more to be found too. 
Take the time to explore the many 
tweaks on offer – you’re bound to find at 
least one extra useful setting.

We’ve hopefully revealed dozens of tips 
you’ll find incredibly useful. Simply 

researching and writing them has 
uncovered new and better ways of 
doing things for us too, and that’s 
ultimately the best barometer of all – if 
you find something that improves your 
own way of doing things, then chances 
are it’ll help others too.

100
Windows 10 features a Game DVR 
function, which allows you to record 
your progress in a game as a movie if 
its hardware supports it. What’s less 
well known is that this DVR function 
works with any app you’ve installed. 

Simply press [Win]+[G] when inside 
your target app and tick ‘Yes, this is a 
game’ when prompted. If you plan to 
share your video with others, it makes 
sense to set it to the correct aspect 
ratio: 16:9 or 16:10 is usually best. ■

restrict Cortana
By default (see tip 86), Cortana favours web 
results over locally stored content when using 
generic search terms. You have to click ‘My 
Stuff’ to search locally. If you have no use for 
Cortana as a web search tool, disable it – open 
Cortana and click the notebook icon (a 
rectangle with a circle on it) on the left before 
selecting ‘Settings’. Flick the top switch to 
‘Off’, which will reveal a new switch – ‘Search 
online and include web results’. Flick this to 
‘off’ and you’ll see the search box now only 
says ‘Search Windows’, confirming it’s no 
longer interested in the web.

98Personalise your  
PC’s information

You can change what’s displayed in 
the System Properties screen to just 
about anything you like (within 
reason). The information is held in the 
registry, but why fiddle about there? 
Instead, fire up Ultimate Windows 
Tweaker and navigate to the 
‘Additional’ section. Click the ‘Edit 
OEM Information’ button and enter 
your details – you can even include a 
logo too. You’ll need to prepare a 
120x120px image in your image editor 
and save it with the .BMP extension, 
otherwise it won’t appear.

97Create new  
folders quickly

There’s no need to lift your 
hands from the keyboard 
when you need to create a 
new folder in Explorer – 
there’s a much simpler way! 
To carry out this handy little 
trick, just use the special 
keyboard shortcut 
[Ctrl]+[Shift]+[N], type a 
name for the folder and 
press [Enter].

99

record app actions  
in windows 10

96Give your start-up  
a good speed-up

Type startup into search and click the best match 
to be taken to the Task Manager’s Startup tab. 
Disable any programs you know you don’t want to 
start with your computer This can reduce its boot 
times significantly.
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 windows tips   internet advice   exciting new projects

Our promise to you…
Get more from Windows, software and all your favourite sites

packed with informative tutorials
Every issue, we guarantee to pack the 
magazine with great tutorials teaching 

you all the best things you can do with your PC. 
Each article features step-by-step instructions 
to make learning new skills fast and enjoyable.

customise windows to work your way
We all know how to do the basics but 
getting the most from Windows isn’t 

always easy. Our dedication to the operating 
system means you get the very best tips and  
tricks for all versions of Windows.

get more from your favourite websites 
We all have our list of favourite sites  
but often we miss out on great features 

because they’re difficult to use or hidden from 
sight. We’ll show you how to do more online, 
for a more satisfying web life.

discover new programs with our help
From speed-up and security software 
to superb photo apps, there’s always 

something new to try on your PC. The 
Windows Store in Windows 10 and Windows 
8.1 is packed with software to download.

Welcome
In the Explore 
section this  
issue we’ve got 
three apps that 
could change  

the way you use your 
computer forever. 

Firstly, there’s the free 
Mouse Without Borders app 
so you can use the same 
mouse and keyboard across 
multiple PCs, then there’s 
Cameyo, which enables you 
to upload your apps to the 
cloud and use them from 
there. Finally, we’ve got the 
brilliant Sandboxie, which 
enables you to try out new 
apps safe in the knowledge 
they won’t cause damage  
to the rest of your system. 

Graham Barlow  
Editor-in-chief 
graham.barlow@futurenet.com

Turn to page 42 
to find out more

Full listing…
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52 Play DVDs, video and  
audio files using VLC

54 Run apps without affecting  
the rest of your system

58 Solve eight major  
Windows 10 annoyances

60 Avoid distractions while  
using your computer

34 Stop your PC from  
crashing using Event Viewer

38 Make better voice recordings 
with the Audacity app

42 Have fun with your photos  
for free with Pixlr Express

44 Use the same mouse and 
keyboard across multiple PCs

48 Use your apps from any  
PC online with Cameyo

Your guide  
Nick Odantzis says…
“It’s a simple way to make  
your pictures look great!”



 Anyone can do it  
 Straightforward 

  Tricky in parts

 Windows 10
 Windows 8.1
 Windows 7

At a glance
Skill level…

Suitable for…

Learn how to…
Stop your PC 
from crashing

“Take a look under the hood of 
Windows to track down the cause 
of stubborn problems”

hy is it that your PC always 
seems to develop problems 
at the most inopportune 

moments? While Windows has largely 
been known to be pretty good at 
fixing its own problems, there are 
those frustrating times when its own 
built-in tools, from self-healing to 
Troubleshooters, fail to do the job.

There’s still no substitute for the 
self-help approach, and one of the 
best tools for this is the Event 
Viewer. It’s where you’ll find 
Windows’ log files, a record of 
everything that’s going on, including 
symptoms of problems both evident 
and still hidden away. By carefully 
examining these logs you can find 
out what’s causing all kinds of 
glitches, from obvious – if cryptic – 
error messages to more vague issues, 
such as sluggish behaviour or 
periodic freezes. Read on to discover 
how to decipher these logs and find a 
solution to your problem.

1 Launch Event Viewer
If you’re running Windows 8 or 10, the simplest way to open 

Event Viewer is to press [Win]+[X] or right-click the Start button 
and select it from the Quick Access menu; if you’re running 
Windows 7, press [Win]+[R] to open the Run dialogue box, then 
type eventvwr and press [Enter]. If prompted by User Account 
Control, click ‘Yes’ or ‘Continue’.

2 Get a summary
The main Event Viewer screen will appear. The middle pane 

should display three sections of information: concentrate on the 
‘Summary of Administrative Events’ section at the top, which 
displays a list of each type of event logged in the past hour, 24 
hours and seven days. Pay particular attention to ‘Critical’, ‘Error’ 
and ‘Warnings’ sections (but don’t panic – yet!).

Step-by-step Fix your PC with Event Viewer

Your guide Nick Peers says…

Filter view
You can examine specific 
parts of your system by 
browsing through the 
available list of logs, or 
create custom views. 

error FrequenCy
In some cases, errors 
and warnings can be 
ignored, but if they keep 
cropping up it’s a good 
idea to investigate them. 

event detAilS
Try to include as much 
detail as the log gives you 
in your searches: event id, 
source (or filenames) and 
any error codes. 

W
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3 Browse events
Click ‘+’ next to a section to expand it and view a summary 

of the events. Focus on event types that last occurred (within the 
hour, 24-hour or 7-day ranges) around the time your problem 
manifested itself. Double-click an event to open its Summary 
page, then use the annotation to help identify possible events 
that correlate to the problem you’re investigating.

4 View event detail
Review all instances of the event type, focusing on the time 

and date each instance occurred. This can help link the event to 
your problem, but go through all event types under ‘Critical’, ‘Error’ 
and possibly ‘Warning’ to see if there are multiple events linked to 
the problem. Make a note of each one, then read on to discover 
how to examine each one in more depth.

Jargon buster!
 event id

The number used to 
identify a specific 
type of event, which 
makes it easier to 
track down other 
instances of the 
problem online.

 Source
The application (or 
part of Windows) 
that logs the event 
being displayed. This 
doesn’t always 
identify the problem 
– check the event’s 
details for specific 
files or drivers.

 task Scheduler
A tool built into 
Windows that 
triggers actions at  
a specified date  
and time, or when  
a certain event  
has occurred.

SeArCh online
This handy link no longer 
works in Windows 10 – don’t 
worry, we’ll show you how 
enter your event details to 
find more advice. 

ASk otherS
If all else fails, 
right-click the event 
to copy its details to 
paste into an email 
or web forum post 
asking for help. 

Nick’s best tiP!
still can’t find a solution? Email 
support squad at 
windowsmagazine@futurenet.
com with your event log details…

Explore 
Fix Windows with Event Viewer
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9 Browsing logs
What happens if you can’t find the information you’re 

looking for? It’s likely the events you need to track are buried 
away. Manually browse the logs to narrow your search. Expand 
Windows Logs in the left-hand pane where you’ll find logs in 
categories. Use Applications to search for program-related 
problems, and System for Windows and hardware.

7 Broaden your search
TechNet may return no results (or simply return some 

generic information about the fault that doesn’t really help). Don’t 
give up, though. Make a note of the Event ID, Source and 
description under the General tab in Event Viewer, then type 
these into a search engine and see what results come up. You may 
find more troubleshooting information via a web page or forum.

5  Get help online
Make a note of the description – the Details tab provides 

more technical data. You’ll notice an ‘Event Log Online Help’ link  
at the bottom of the General tab, which if you click throws up  
the message shown – sadly, this doesn’t work in Windows 10,  
but don’t worry. Instead, open your browser and go to  
www.microsoft.com/technet/support/ee/ee_advanced.aspx.

10 Filter logs
Logs record all manner of information, much of it irrelevant 

– at least when troubleshooting a problem. Click the ‘Filter 
Current Log’ button in the right-hand pane to filter the list a 
number of different ways: by the time it occurred, the type of 
event (focus on critical, error and warning), Event sources, IDs, 
keywords or any combinations. Click ‘OK’ when done.

8  Narrow your search
If too few results are returned, search for fewer words or 

omit the Source or Event ID from your terms. If too many results 
come back, narrow it by including more information. Include 
specific references to filenames in the event log, for example, or 
provide more general information, such as your version of 
Windows, hardware device or software program.

6 Search TechNet
Select ‘Windows Operating System’ for Microsoft Product, 

but leave ‘--All Versions--’ selected. Type the Event ID number into 
the ‘Event ID’ box, and the same source as listed in Event Viewer 
(for example, ‘Application’) into the ‘Event Source’ box. Click ‘Go’ 
and a list of matching results will be shown. Click one to read 
more about the problem; if there are multiple entries, try them all.
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15 Remove alert
Eventually you may no longer want that alert popping up 

(because you’ve fixed the problem!). To remove it, open Task 
Scheduler –type scheduler into the Search box and click ‘Task 
Scheduler’ when it appears, or press [Win]+[R], type control 
schedtasks and click ‘OK’. Expand ‘Task Scheduler Library > Event 
Viewer Tasks’, right-click the alert and choose ‘Delete’ then ‘Yes’.

13 Schedule alerts
Event Viewer also lets you create alerts that are triggered 

when specific events occur. This can be useful for troubleshooting 
underlying problems as you may find a seemingly unrelated 
event is triggering the error, or get early warning that something 
nasty is about to happen. Once you’ve located the event you wish 
to monitor, right-click it and choose ‘Attach Task to This Event…’

11  Create a custom view
If you want to create a filter that provides you with 

information across multiple logs, or wish to create a filter you can 
easily access in future, click ‘Create Custom View’ under ‘Actions’. It 
works in the same way as the filter – to monitor more than one 
log with your custom view, click the ‘Event logs’ dropdown menu 
and tick the logs you wish to include.

16 Troubleshooting made easier
Now you’ve discovered the basics of how Event Viewer 

works, you can use it to help you track down problems in the 
future. By examining your system logs using its interface, you 
should be able to locate the information you need to go out and 
not just diagnose what’s ailing your PC, but also hopefully find a 
solution to bring it back to good working order too. ■

14  Create alert
Change the name to something that will help you recognise 

it in task Scheduler (see next step), and click ‘Next’ twice. Neither 
email or ‘display a message’ options work, so leave ‘Start a 
program’ selected and click ‘Next’. Type msg into the Program/
script box, then type * followed by your message (for example, 
‘*Error Alert’) into ‘Add Arguments’. Click ‘Next>Finish > OK’.

12 Save your view
Click ‘OK’, then give your custom view a suitably descriptive 

name and choose where to save it within the ‘Custom Views’ tree 
in the left-hand pane. Going forward you’ll be able to access this 
view at any time directly from here – it’s the perfect shortcut for 
targeted troubleshooting that will take an extended period of 
time to monitor and act upon.

Explore 
Fix Windows with Event Viewer
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  Anyone can do it 
 Straightforward 

 Tricky in parts

 Windows 10
 Windows 8.1
 Windows 7

At a glance
Skill level…

Suitable for…

Learn how to…
Make better  
recordings

“Give your music, podcasts and 
other sound recordings a coat of 
professional polish with Audacity”

ith an inexpensive PC 
microphone it’s easy to 
record your own podcasts, 

music, audio books or narration for 
videos. The results can sound great, 
but by taking a little time to enhance 
them, you can bring them up to 
professional standards. Audacity is 
the perfect software for this; it’s 
powerful but easy to use, and it’s free.

Audacity does an excellent job of 
cleaning up audio, but there are steps 
you can take to ensure you get the 
best possible recording quality in the 
first place. First, make sure the input 
volume is set by right-clicking the 
speaker icon in the System Tray, 
selecting ‘Recording devices > 
Microphone > Set up microphone’ 
and following the instructions.

It’s also worth using a pop filter to 
prevent noises created by rapid 
movement of air as you’re singing or 
speaking. Make your own here:  
http://bit.ly/2fCcHwU.

1 Get Audacity
Visit www.audacityteam.org/download/windows and select 

the first option – Audacity 2.1.2 installer. This version contains 
additional help files, in case you need them later. The download 
will start automatically; ignore the links that appear on the 
following page. Run the software installer, leaving the default 
settings as they are.

2 Mic check
Launch Audacity and take a look at the microphone and 

speaker settings at the top. Make sure these are set correctly so 
you aren’t recording from your webcam rather than your USB 
microphone, for example. If you’re not sure which device is 
selected, click the area marked ‘Click to start monitoring’ and the 
input from the selected microphone will be shown as a green bar.

Step-by-step Enhance your recordings with Audacity

Your guide Cat Ellis says…
RecoRd And plAy
Use these to make 
and listen to 
recordings. Hover 
your mouse over 
each one to see its 
corresponding 
keyboard shortcut 
and any variations. 

Quick contRolS
Use these buttons to cut, 
copy and paste sections  
of audio. You can also mute 
a section (Silence), or cut 
away everything before  
and after it (Trim). 

effectS
Here you’ll find all of 
Audacity’s tools for 
refining recordings, 
plus creative options 
such as Auto Duck, 
which lets you speak 
over a music track by 
lowering its volume. 

W
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3 Make your recording
Click the red button or tap [Shift]+[R] to start recording. Try 

to keep a consistent distance from the microphone, and don’t 
worry if you trip over a word – pause for a second and say that 
part again. You can easily cut any mistakes afterwards. Once 
you’re done, click the rewind button, then click play to see how it 
sounds. It’s best to use headphones for this.

4 Remove noise
If you notice background noise in your recording, select a 

quiet part of the recording by clicking and dragging on a flat part 
of the blue waveform. Click ‘Effects > Noise reduction’, then click 
‘Get noise profile’. Tap [Ctrl]+[A] to select your recording and click 
‘Effects > Noise reduction’ again, then use the sliders and preview 
to adjust the strength of the effect. When you’re happy, click ‘OK’.

Jargon buster!
 Waveform

A graphical 
representation of 
recorded sound. The 
taller the peaks, the 
louder the volume.

 WAV
A format for storing 
uncompressed 
audio. When you 
export a file in WAV 
format, all the data is 
kept, making it the 
best choice for audio 
you want to work 
with and edit again.

 Mp3, WMA
The most common 
compressed audio 
file formats. They are 
created by extracting 
data that will be 
inaudible to the 
human ear, and can 
be played by almost 
any media software.Selection

Click and drag on the 
waveform to select part 
of the recording. If you 
want finer control, tap  
[Ctrl]+[1] to zoom in. 

WAVefoRM
A representation of  
your recording.  
Audacity records in 
stereo by default, so 
there are two tracks  
(left and right) with 
identical waveforms. 

Cat’s best tip!
Consider the room where you’re 
recording. soft furnishings, carpet 
and curtains all help to reduce echos 
and cut down background noise.

RecoRding And 
plAybAck
Make sure you have 
the right input and 
output devices 
selected to ensure 
you aren’t recording 
via your webcam 
instead of your  
USB microphone,  
for example. 

Explore 
Make better recordings
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9 Tone down harsh sibilance
Re-open your file, selecting the option to make a copy in 

case you need to undo your changes. Now select ‘Effects > Add/
remove plugins > SPITFISH > Enable > OK’. Tap [Ctrl]+[A], then 
click ‘Effect > Spitfish de-esser’ and experiment with the settings 
to tone down the sibilance. As before, the exact settings required 
will depend on your own recording.

7 Lower peaks
If there’s a single particularly loud part of your recording, 

select it, then tap [Ctrl]+[1] repeatedly to zoom right in and isolate 
the specific waves that are causing it. Make sure you have just 
these waves selected then click ‘Effect > Amplify’ and reduce the 
volume by a few decibels. Use the ‘Preview’ button to check how 
it sounds before clicking ‘OK’. Tap [Ctrl]+[T] to zoom back out. 

5 Trim to size
If there’s a pause at the start of your recording that you 

don’t want, click and drag to select this part of the waveform and 
tap [Delete]. You can also use this technique to remove any 
sections of audio where you made a mistake and had to repeat 
yourself. If you only want to keep a small part of the recording, 
select that section and click ‘Trim Audio’ beside the ‘Paste’ button. 

10 Export and save
Your audio should now sound much better! Tap ‘File > 

Export Audio’ and choose a file type. If you’re planning to edit it 
again later, or use it as a soundtrack for a video, save it in WAV 
format to keep the quality high. If it’s finished and you’re ready to 
share, save it in Mp3 or WMA format; these provide compression 
to reduce file size, and are supported by most media players. ■

8 Get Spitfish
Harsh ‘s’ sounds are a common problem in home audio 

recordings. But, there’s a plugin for Audacity called Spitfish that 
can reduce them. Download it from http://bit.ly/1i1zfRG. Extract 
the ZIP archive to ‘Program Files (X86) > Audacity > Plugins’. 
Return to Audacity, click ‘File > Export Audio’, save your audio in 
WAV format and then restart the program.

6 Adjust levels
Did you accidentally move away from your microphone 

while you were recording? If so, some parts of the resulting audio 
might be louder than others. If that’s the case, tap [Ctrl]+[A] to 
select everything, then click ‘Effects > Levelling’ and experiment 
with the options, checking them with the ‘Preview’ button (the 
amount of levelling required will depend on your own recording).
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Learn how to…
Have fun with your 
photos for free

“Are you struggling to take interesting photos?  
Well fear not, because here’s a simple way  
to make all your pics look really great!”

espite the fast-paced 
progress of photographic 
technology, taking a great 

shot still isn’t as easy as the experts 
would like us to believe. There are so 
many factors to consider at the time 
of exposure, that it’s easy to mess 
things up. But rather than get 
stressed when you don’t get the 
instant results you’d like, you can pick 
up the pieces afterwards, even with a 
photo that isn’t your best effort. And, 
as ever, software is at hand to help. 

Pixlr Express is an easy-to-use 
internet-based photo-editing 
application that enables you to give 
your photos a new lease of life, 
completely free of charge. 

We’ll show you how to get the 
results you want without the 
photographic prowess, plus we show 
you how to have some fun with your 
images too!

1 Load a photo
In order to edit your photos you’ll need to get them onto 

the Pixlr Express website. Go to pixlr.com/express to upload a 
photo – there are four ways to do this, but we’re going to use the 
Browse method, so click this, navigate to where your photos are 
stored, select one and click ‘Open’. It’s worth mentioning that you 
can only edit one photo at a time.

2 Basic controls
It’s worth familiarising yourself with the basics. With your 

photo loaded, you’ll see it in the main area of the browser window 
– any changes you make will appear here. In the top-right corner 
you’ll find the main controls, allowing you to zoom in or out of 
photos, undo or redo changes and more. In the top-left corner 
you can save or close photos that you’re working on.

Your guide Nick Odantzis says…

D

Nick’s best tip
Make duplicates of  
your photos by copying  
and pasting them into  
a new folder.

Step-by-step Enhance photos with Pixlr Express

  Anyone can do it 
Straightforward 
Tricky in parts

 Windows 10
 Windows 8.1
 Windows 7

At a glance
Skill level…

Suitable for…
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7 The finishing touches
You can also edit each of the images within your collage to 

make them stand out. To edit an individual image, hover over the 
one you want in the collage and three options in the top-right will 
appear. The left option lets you change the image for another, 
while the right lets you delete it. The middle button opens up the 
image-editing option, allowing you to adjust the photo.

8 That’s it!
There are loads of features hidden in this free and powerful 

application, but if you just want to have a play around and find 
the filters you like without having to commit to anything, tap the 
heart button (located next to each image) to make them your 
favourites. The next time you open a filter type, it’ll give you an 
option to choose from your favourites. Have fun! ■

5 Bring photos to life
‘Stickers’ and ‘Type’ add another dimension to your images. 

Click ‘Stickers’ and choose from the selection, but try not to go 
mad as your photo might look a cartoon explosion! Next is ‘Type’ 
– select this and you can make your photo more descriptive. 
Choose a text type and write into the box below. You can move 
‘Sticker’ or ‘Type’ boxes around the screen and resize them.

3 Simple photo editing
Your photo might just need some simple edits to improve it. 

Click the ‘Adjustment’ button in the lower menu and a few new 
options will appear above. Click on the one you want to use and 
you’ll see controls for that option appear in place of the current 
menu. Make the changes, then either click ‘Apply’ to make them 
happen or ‘Cancel’ to go back.

6 Create a collage
As well as editing single images, you can create collages. 

Close your current image and select ‘Collage’ from the menu. By 
default, you’ll see a collage of four windows, each of which can 
have a photo added to it – hover over a window and click to load 
a photo. If you want a different type of collage, choose a new one 
by clicking ‘Layout’ and choosing another.

4 Add effects
The ‘Effects’ option offers dramatic filters to completely 

change the way your photo looks, whether it’s nightvision or 
60s-style vintage. When you click on the type you like, it’ll bring 
up more options that you can flick through left-to-right by using 
the arrow buttons. When you’ve chosen one, you can adjust the 
level of transparency of an effect by using the slider.
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  Anyone can do it 
Straightforward 
Tricky in parts

 Windows 10
 Windows 8.1
 Windows 7

At a glance
Skill level…

Suitable for…

Learn how to…
Move across 
multiple PCs

“Easily switch your mouse and 
keyboard between devices 
without unplugging a thing!”

ouse Without Borders is a 
free tool from Microsoft 
that allows you to use one 

set of keyboard and mouse across a 
number of computers without 
having to unplug them. This means 
if you have two PCs on your desk 
connected to two monitors, you 
only need one keyboard and mouse 
to control either of them. 

It’s also useful if you often use  
a laptop alongside your desktop  
PC, but find the smaller keyboard 
and trackpad of the laptop 
uncomfortable to use. The app 
comes with loads of other great 
features as well, such as the ability 
to remotely log in and out of the 
connected PCs and easily share 
files and folders between devices 
by simply dragging and dropping 
them. Read on to find out all the 
amazing things you can do with 
this software.

1 Install Mouse Without Borders
Mouse Without Borders is a Microsoft Garage project, and it 

can be installed from http://bit.ly/2go2F4a. Head to that website 
and click on ‘Download’. Your web browser should now start 
downloading the installer file (which will have the .msi file 
extension). If the install wizard doesn’t start automatically once 
it’s downloaded, click on the file to begin.

2 Install Mouse Without Borders
Depending on your browser, the installation wizard will 

start automatically, or double-click on the MouseWithoutBorders.
msi file – which should be in your Downloads folder. When the 
first window appears it will explain what the program does. Click 
‘Next’ to continue, then agree to the terms and conditions and 
click ‘Install’. The process shouldn’t take long, as it’s a light file.

Step-by-step Use Mouse Without Borders

Your guide Matt Hanson says…

CoMPuter order
The Computer Matrix area of 
the screen shows you the 
order of your connected PCs. 
Drag and drop these so they 
reflect the real-world 
locations of your PCs. 

SeCurity key
This is the key you use to 
allow trusted PCs to connect 
via Mouse Without Borders. 
Click ‘Show text’ to reveal the 
key, then enter it in during 
the setup procedure. 

other oPtionS
For more options on how the 
app behaves, click on the 
‘Other Options’ tab. This will 
show you advanced options, 
so it’s best to leave this until 
you’re used to the app. M
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3 Repeat the process for the other devices
The app allows you to control four different devices with 

one keyboard and mouse, so download and install the application 
on every PC you want to control. To make the process quicker, go 
through steps 1 and 2 of this tutorial on every PC you want to use. 
Remember, as this program was made by Microsoft it only works 
on Windows PCs.

4 Getting started – part one
When the app has finished installing on your main PC, click 

‘Finish’. This will launch the application. A window will appear 
asking you if you have already installed the app on another 
computer. Because this is the main PC we’re setting up, click on 
‘No’. The next window will display a security code made up of 
numbers and letters, and your main computer’s name.

Jargon buster!
 Microsoft Garage

Microsoft Garage is a 
place where 
Microsoft’s 
developers release 
experimental and 
interesting projects 
and apps, such as 
Mouse Without 
Borders. Check it  
out at https://www.
microsoft.com/ 
en-us/garage.

 kVM switch
KVM switch stands 
for ‘Keyboard Video 
Mouse’ switch and 
these are usually 
hardware devices 
that let you switch 
one keyboard, 
mouse and monitor 
between a number 
of devices. Mouse 
Without Borders 
doesn’t switch 
monitors, but unlike 
most KVMs it’s 
wireless, making it 
more convenient.

 Mouse cursor
The mouse cursor is 
the icon on your 
screen (usually an 
arrow) that 
represents your 
current position.AdditionAl PCS

If you don’t use up all 
four PC slots they will 
appear greyed-out. You 
can stop the app from 
using any PC by unticking 
the box. 

re-run SetuP
If for any reason you want to 
rerun the setup process, then 
click the ‘Go through the 
setup experience’ link to go 
through the steps again. 

MiniMiSe MouSe 
Without BorderS
The app’s window 
appears at the top of 
any open window – 
click ‘Minimise’ if this 
annoys you. 

Matt’s best tip!
the keyboard follows your 
mouse, so if the cursor moves 
to a second pC, you can still 
use your first pC’s keyboard!

Explore 
Move across multiple PCs
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9 Jump between PCs with keyboard shortcuts
If you want to quickly move your mouse and keyboard to a 

connected computer, hold down [Ctrl]+[Alt] on your keyboard, 
then press [F1], [F2], [F3] or [F4] on your keyboard, depending on 
which PC you want to go to. They are in the same order as the PCs 
displayed in the Computer Matrix part of the screen, so the 
computer on the far left is F1, the second is F2 and so on.

7 Change the order of your PCs
By swapping your mouse cursor from one PC to the next as 

you go to the side of the screen, it will feel like you have one big 
desktop. But, if your PCs aren’t set up in order (i.e if the main PC is 
to the right of the second) then it can be confusing. To change the 
order, click on one in the Computer Matrix and drag. If you have 
the monitors above and below each other, click ‘Two Row’ as well.

5  Getting started – part two
Keep this window open, then on your other PCs finish the 

installation process, and when the window appears asking if you 
have already installed the app on another PC, select ‘Yes’. Enter in 
the security code and name of the first PC you installed the app 
on. Do this, then click ‘Link’. Once the PCs have connected to each 
other (make sure both are on the same Wi-Fi network), click ‘Next’.

10 Other options
 For even more control over how the application works, click 

on the ‘Other Options’ tab at the top of the screen. Here you’ll see 
a number of advanced options, allowing you to change how the 
mouse behaves when moving between PCs, while also changing 
the keyboard shortcuts so that the program works just the way 
you want it to. ■

8  Copy and paste files between PCs
Mouse Without Borders lets you move files and folders 

between PCs. Just click on the file you want to move, then drag it 
to the new machine and drop it – the file will be copied across 
just as easily as if you were moving the file on one PC. You can 
also right-click on a file, select ‘Copy’ and then move the mouse to 
another PC, right click and select ‘Paste’.

6 Control all PCs with one keyboard and mouse
You can use the app in a similar way to a physical kVM 

switch, allowing you to share a keyboard and mouse between 
devices. In the Computer Matrix part of the app’s window you’ll 
see the PCs you’ve installed the app on, with the main one on the 
left. Move your mouse to the right-hand side of your screen – it 
will appear on the next PC!
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 Anyone can do it
  Straightforward 
Tricky in parts

 Windows 10
 Windows 8.1
 Windows 7

At a glance
Skill level…

Suitable for…

Learn how to…
Use your apps  
anywhere

“Upload your favourite software to 
Cameyo and access it from any PC 
without installing it”

ameyo is a great tool that 
lets you run Windows 
software in a web browser 

without installing it. It comes with 
lots of programs, including popular 
photo editors, word processors and 
media players, and you can add your 
personal favourites too.

Next time you have to use a 
computer that isn’t your own, you 
don’t need to worry if you don’t have 
time or permission to install your 
favourite programs. Just log into 
Cameyo’s website and there they are, 
ready to run. You can even use it to 
run Windows software on a Mac!

Cameyo works by turning any 
Windows program into a portable 
app – a single file that contains 
everything the program needs to 
run. It stores these files on its own 
web servers, and you can access 
them through any browser that 
supports HTML5. 

1 Make an account and log in
To get started, visit www.cameo.com and click ‘Sign up’. 

Enter your email address and a password, then click ‘Register’. 
Cameyo will send you a confirmation email with a link to activate 
your account; click this and you’ll be logged in and taken to 
Cameyo’s library of public apps, including office software, photo 
editors, PC optimisation tools and media players. 

2 Open a public app
Move your mouse over a program’s tile and some icons will 

appear in the top right. The ‘i’ gives you more information, the 
down arrow lets you download it, and the play button (if present) 
lets you use it in your browser right now. Click play and a new tab 
will open in your browser. After a little while (depending on the 
speed of your internet connection), the program will open there.

Step-by-step Use apps online with Cameyo

Your guide Cat Ellis says…

App LibrAry
Here you’ll find 
all the programs 
pre-installed. 
Move your 
mouse over an 
icon; if you see  
a play button, 
you can run it in 
your browser. 

My AppS
All the programs 
you’ve packaged 
and uploaded to 
Cameyo. They will 
remain here for 
seven days. 

C

Add App
Got a favourite 
program that’s not in 
the library? Follow the 
instructions in the 
walkthrough below 
to package it, then 
click here. 

48  |    |  February 2017



3 Work in your browser
Programs running in your browser work almost exactly the 

same as they do on your desktop – they use the same menus, 
controls and keyboard shortcuts. The only difference comes when 
you want to open a file. Use the program’s menu system as 
normal and Cameyo will guide you through the process of 
uploading files so you can work on them.

4 Pick your own program
If your favourite program isn’t available as a public app, it’s 

easy to upload it yourself. First, download the software you want 
to be able to run in your browser, but don’t install it. We’ve chosen 
the free photo viewer ImageGlass from www.imageglass.org. Bear 
in mind that the program must be less than 50MB in size.

Jargon buster!
 portable app

A single EXE file that 
contains all the data 
a program needs to 
run. It can run 
directly from a USB 
stick or any other 
storage medium.

 HTML5
A language used to 
present content 
online. Most popular 
web browsers 
support HTML5.

 Local machine
Your own PC (as 
opposed to a  
web server).

UpLoAd froM 
yoUr pC
Cameyo turns 
programs into 
portable apps  
that you can 
upload straight  
to the website. 

find THe pACkAge
When Cameyo packages 
an app, it stores the file  
in your Documents 
folder with the 
extension ‘.cameyo.exe’ 

deSTinATion
Packaged apps are 
stored on Cameyo’s 
servers by default, but 
you can also keep 
them in a connected 
Dropbox account. 

Cat’s best tip!
the free version of Cameyo 
keeps your software online 
for seven days.

Explore 
Use your apps anywhere
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9 Adjust settings
You’ll now see a page with information about your 

uploaded program. Here you can change various settings that will 
be helpful for other people who might want to use it – pick a 
category, upload some screenshots, and write a description. You 
can also create a link to share with other people who might be 
interested, and choose whether or not it should be listed publicly.

7 My Apps
Once your software installation has been successfully 

recorded, Cameyo will ‘package’ and store it in your Documents 
folder. Reopen your browser and go to https://online.cameyo.
com/apps/my. As the name suggests, My Apps is where all the 
programs you upload will appear. In the free edition of Cameyo, 
they will remain here for seven days after you upload them.

5 Get Cameyo’s software
Now go back to www.cameyo.com and click ‘Download’. 

Cameyo warns that some antivirus programs mistakenly flag it as 
a potential threat. If you receive a warning like this, it’s up to you 
to use your judgement and decide whether you’re happy to carry 
on. If you are, click the downloaded file cameyo.exe and select 
‘Capture an installation’. 

10 Use your app anywhere
Now you can visit www.cameyo.com on any PC, log in using 

your account details, click ‘My apps’ and select your program to 
run it directly in your browser. If you want to use it on your phone, 
download the Cameyo app from http://bit.ly/2gyQeSO and log in 
using the same details. You can uninstall the software from your 
PC now – you don’t need it there anymore! ■

8 Upload the package
Click ‘Add app’, then select ‘Upload your existing Cameyo 

package’. Click ‘Local machine’, then browse to your Documents 
folder and open the new Cameyo Apps folder. Inside you’ll find a 
file named after the program you installed – select this and click 
‘Open’. Click ‘Submit’ and the package will be uploaded. This 
might take a little while, so be patient.

6 Record an installation
Cameyo will now take a snapshot of your PC’s files and 

folders. Don’t do anything else while this is happening. When it’s 
finished, find the program you downloaded in step 4 and install it. 
If you’re prompted to reboot your PC during the process, do so. 
When you’ve finished click ‘Install done’ and Cameyo will take 
another snapshot to see which files and folders have changed.
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Learn how to…
Play any video file 
or DVD using VLC

“VLC is a must-have app for anyone who  
has an ever-growing library of movies  
and music in lots of different formats”

here are plenty of media 
players out there for 
Windows 10 – including the 

pre-installed ‘Films & TV’ media 
player, which is how your media will 
open by default. But the one that 
really stands out is VLC. Available as a 
desktop version or a player 
specifically suited to Windows 10 
touchscreens, there’s nothing better 
to handle your entertainment needs. 
VLC can handle most types of file, 
from the mkv video format to FLAC 
hi-res audio files, and you can also 
add subtitles to videos, too. 

Here, we’re looking at the newer 
Windows 10 Store version of the app; 
though not as fully featured as the 
desktop version (it doesn’t play DVDs 
or Blu-rays), it’ll do almost everything 
else.  And since the app is designed 
to work with Windows 10, if you have 
a very high-res screen, the controls 
scale up, unlike the desktop version.

1 Install the app
To get VLC you’ll need to head to the Store – click on the 

icon in the Taskbar at the bottom of the screen (the shopping 
bag) and in the search bar at the top of the app, type vlc and 
select the VLC app from the drop-down menu that appears. Now 
click ‘Get’ next to the app icon and it’ll download and install on 
your PC. Once finished, click ‘Launch’.

2 Find your media
Any videos contained in your Videos folder, or any music in 

your Music folder, will appear in the main area of the VLC app. To 
refine the type of media you see, use the options at the top of the 
app. If you want to search for a specific video or music file, hit 
browse to navigate to a file within the videos or music folders. Or, 
click ‘open file’ to browse to a location on your hard drive.

Your guide Nick Odantzis says…

T

Nick’s best tip
keep off the mouse cursor for 
a few seconds and the menu 
in a video will auto-hide, 
giving you a clear view.

Step-by-step Get VLC and enjoy your media more

   Anyone can do it 
Straightforward 

 Tricky in parts

 Windows 10
 Windows 8.1
 Windows 7

At a glance
Skill level…

Suitable for…
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7 Play DVDs or Blu-rays
You can’t play optical media using the Store app version, so 

open the desktop version of VLC instead. If don’t have it, go to 
www.videolan.org and the Downloads area. When VLC desktop 
version is open, insert your DVD or Blu-ray. Then go to ‘Media > 
Open Disc’ and in the ‘Disc Selection’ area choose the type of disc. 
Now click ‘Browse’, and double-click its location under ‘This PC’.

8 Sit back and enjoy...
By using the VLC app for Windows 10, you’ll have all your 

media needs covered, giving you the ability to watch any type 
of videos and listen to all kinds of music, whether your files are 
stored locally, or if you’ve got them on a network drive 
somewhere around the home. Now all that’s left for you to do 
is get hold of some good media to keep you entertained! ■

5 Try advanced video settings
There’s a handy feature available with VLC that enables 

you to adjust the video and audio synchronisation, which helps 
if you’re having problems with a delay in audio when something 
happens on screen. To adjust this, click the ‘player settings’ 
button. Play with the ‘audio delay’ slider to get video and audio 
in sync.

3 Play movies
To open a movie, double-click it and the VLC player will 

appear in place of the file menu. Within the player you can 
control your movie using the options in the lower menu. The play 
button is located centrally, volume on the right and minimise/
maximise on the left. The timeline enables you to skip to any part 
of the video.

6 Play music
To listen to songs, click ‘music’ in the top menu. Any music 

contained within the Music folder on your PC will appear here; 
you can refine selection by artist, album or song using the sub 
menu. You can play an album, or just a song. If you want to create 
a Playlist of tunes, hit ‘Playlists’ in the top, click the + button and 
select a name. When you right-click a song, add it to that playlist.

4 Control audio or subtitles
As well as basic controls, the video player window offers 

some more advanced adjustments – should you need them. 
Just click on the speech bubble to change the default audio 
language and subtitles, if they’re available. Alternatively, you 
can select ‘Open subtitles’ and add your own if they don’t appear 
in the options.

Explore 
Play any media using VLC
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 Anyone can do it  
 Straightforward 

  Tricky in parts

 Windows 10
 Windows 8.1
 Windows 7

At a glance
Skill level…

Suitable for…

Learn how to…
Run apps in  
a sandbox 

“Don’t want an app to access  
the rest of your system? Run it  
in a sandbox, instead”

hen downloading files from 
the internet, there’s always 
the risk that you may 

download a program that’s actually a 
virus. Sometimes even downloading 
a safe file comes with additional 
software you didn’t ask for, which 
installs itself and plays havoc with 
your system – changing default 
settings or switching the home page 
of your web browser, for example. To 
ensure these apps don’t damage your 
system you can run them in what is 
known as a sandbox. This runs them 
separately from the rest of Windows, 
which means the program won’t 
access important files and make 
changes. Running a program in a 
sandbox is quite advanced, but the 
Sandboxie app makes it easy. We 
show you how!

1 Download Sandboxie
Head to the Sandboxie website (www.sandboxie.com),  

and where it reads ‘Sandboxie now supports Windows 10’ click  
on the ‘Click here’ app. Once downloaded, open up the .exe file 
and the installation wizard will begin. Click ‘I Agree’ on the 
Licence Agreement page, select the location to install the app, 
then click ‘Next’.

2 Installing drivers
As part of the installation, Sandboxie will ask you to install a 

system-level driver. This is essential to allow Sandboxie to emulate 
Windows and run software in a sandbox environment. Click ‘Next’ 
to install the drivers – you’ll need to have administrator privileges. 
In the event of something going wrong with the drivers, restart 
Windows in Safe Mode and uninstall Sandboxie.

Step-by-step How to use Sandboxie

Your guide Matt Hanson says…

W

Matt’s best tip!
Move a program out of the 
sandbox once it ’s safe – 
running apps in a sandbox 
can make them slow.
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Web bRoWSeR
Click the ‘Sandboxed Web Browser’ 
shortcut on your desktop to open 
your web browser in a sandbox. It will 
appear and behave just like your 
normal browser, but, when you hover 
over it, a yellow outline will appear.



3 Running Sandboxie for the first time 
When you launch Sandboxie for the first time, a window will 

appear and it may list a number of applications already installed 
on your machine that need to be configured to work better with 
Sandboxie. Press ‘OK’ to allow Sandboxie to configure them, but if 
there’s any you want to leave alone, select them, then tap on 
‘Remove’ to remove it from the list.

4 Known conflicts
Some apps – such as antivirus software – may not allow 

Sandboxie to run correctly. If you have any of these programs 
installed, the ‘Known Conflicts’ button will flash. Click on it, and a 
Window will appear telling you what programs were found with 
that conflict. Click ‘Yes’ to open the Known Conflicts web page and 
search for what workarounds you need.

Jargon buster!
 .exe

Files that end  
with .exe are 
executionable files 
that launch a 
program. Sandboxie 
is the perfect place 
to test these files. 

 Notification area
The Notification area 
is located on the far 
right-hand side of 
Windows’ task bar, 
just next to the date 
and time. This is 
where icons for 
many programs  
that run in the 
background reside. 

 Email program
An app such as Mail, 
Outlook or Mozilla 
Thunderbird that 
allows you to read 
and reply to emails 
from your desktop, 
rather than having to 
log into a website.

SAndboxed 
ApplicAtionS
In the main Sandboxie 
window you can see the 
applications that you’re 
running in a sandbox. 
Right-click on a program to 
access advanced options.

SAndbox optionS
Click here to create  
a new sandbox, or 
view the folder 
where downloaded 
files appear.

configuRe SAndboxie
Click here to access 
configuration options for 
Sandboxie and the 
sandboxes that it creates.

notificAtion icon
Right-click the Sandboxie 
notification icon in the 
notification area of the 
taskbar for quick access to 
Sandboxie’s options.

Explore 
Run apps in a sandbox
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9  Run your emails through Sandboxie
Another regular source of viruses is through emails. To make 

sure you’re completely protected you can run your email program 
through Sandboxie. This means you can then open up 
attachments from emails without worrying about if its infected. 
Right-click the Sandboxie icon and select ‘DefaultBox’ then ‘Run 
Email Reader’.

7 Run programs in the sandbox
If you want to run a program in the sandbox to try it out, 

right-click on the yellow Sandboxie icon in the notification area. 
You may need to expand the notification area by clicking the up 
arrow. Select ‘DefaultBox’ then ‘Run any program’. Now add the 
location of the program’s .exe file into the text box. You can also 
click ‘Browse’ to find the .exe file on your hard drive.

5  Open the sandboxed web browser
Once Sandboxie has finished configuring itself and other 

programs, a tutorial will take you through the basics of how 
Sandboxie works. At the end of the tutorial, you’ll be invited to 
hide the Sandboxie window and open up the sandboxed web 
browser. You’ll see an icon on your desktop for the Sandboxed 
Web Browser. Click this to open it.

10  Go pro
You now know how to use Sandboxie to keep your 

computer safe! And, while Sandboxie is really great for keeping 
your home PC safe, it can be also used in a work environment to 
keep essential files and programs free from infection, but you will 
need to buy a commercial licence. Go to www.sandboxie.com to 
find out more. ■

8 Delete the contents of the sandbox
Once you’ve finished downloading and testing files you can 

easily delete them from the sandbox, leaving no trace of them on 
your PC. To do this, right-click on the yellow Sandboxie icon in the 
notification area and select ‘DefaultBox’, then ‘Delete Contents’. 
Remember to move everything you want to keep onto your PC 
before doing this.

6 Using the browser
Some websites are infected with viruses that try to 

download themselves in the background when you visit them. 
These ‘drive by’ viruses won’t harm you if you use the sandbox. 
When you download a file using the web browser in the sandbox, 
the file will be saved in the sandbox, so you can test it before you 
move it to your main PC.
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Learn how to…
Solve eight major  
Windows 10 annoyances

“Here are eight quick fixes for the sort of  
problems that can stop you getting stuff done  
on your PC. Let’s get started!”

here are so many different 
settings available in 
Windows 10, but it’s hard to 

know where they all are. Quite often 
you know what you want to do, but 
you don’t know where to start 
looking to get it done. Over time,  
you might find certain things start  
to grate, such as prompts that 
frequently remind you of something 
you don’t care about, or not being 
able to open files the way you’re  
used to. While it’s easy to ignore  
such things, it’s also easy to make 
some simple tweaks and have a 
better version of Windows 10 at  
your fingertips. 

And, that’s just what we’ll show 
you how to do. We have eight ‘hacks’ 
that make your PC experience a much 
smoother one. Don’t let the word 
‘hack’ scare you either – these are just 
simple tricks that anybody can try 
out, and if you don’t like the result, 
just put it back how it was before.

1 Open PDFs your way
We like opening PDFs the old-fashioned way in a dedicated 

PDF reader. You can do this by typing default app settings into 
the Taskbar search, then clicking on ‘choose default applications 
by file type’. Scroll down until you see a .pdf file type. You’ll see 
Microsoft Edge is the default app. Change this to another default 
by clicking on it and choosing it from the list that appears.

2 Use Google search
When you click on the search box in the Taskbar and type 

something in, Cortana will also search online using Microsoft’s 
search engine Bing. If you prefer to use Google, go to ‘Settings > 
System > Default apps > Web browser’ and set this as ‘Google 
Chrome’. Now open Chrome and install Chrometana Chrome from 
http://bit.ly/1M3qcno and choose Google in the page that opens.

Your guide Nick Odantzis says…

T

Nick’s best tip
An easy way to improve 
Windows 10 is to learn some 
shortcuts - this will instantly 
make you more productive.

Step-by-step Solve Windows 10 annoyances

 Anyone can do it 
  Straightforward 
Tricky in parts

 Windows 10
 Windows 8.1
 Windows 7

At a glance
Skill level…

Suitable for…
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7 Disable the login screen
If you have little need for a password it can be annoying to 

always have to enter one at the login screen. But there’s a trick 
that allows you to remove that process altogether. Go to your user 
accounts area by typing Run into the Taskbar search and then 
type netplwiz into the box and hit ‘Enter’. Where it says ‘Users 
must enter a password…’ uncheck the tick box, then restart.

8 Grab a screenshot
There are many instances where screenshots are handy, but 

how do you take one? The easiest way is by holding the Windows 
key and pressing the [PrtScn] button. Windows will capture your 
whole desktop and pop the resulting image into your ‘Pictures > 
Screenshots’ folder. To capture a specific part of your desktop, use 
the Snipping Tool (type snipping tool into the Taskbar search). ■

5 Get your life organised!
To use your calendar, type calendar into the Taskbar search, 

open the result and click ‘Get started’. If you have an email 
account set up, you’ll see it under ‘Accounts’. Hit ‘Ready to go’ to 
open ‘Calendar’, then click ‘+ New Event’. If you use other 
calendars, you can sync events. Hit ‘Settings > Manage accounts > 
Add account’, and choose your email you’ll now see all events.

3 Manage your battery
Turning on Power Saver is a quick trick for hanging onto 

power on long excursions. Windows 10 also comes with a Battery 
Saver feature, which kicks in when your power drops below a 
certain amount and turns off battery-draining features. To get to 
this feature, type battery saver into the Taskbar search, and click 
on the result. Then toggle the switch to ‘On’.

6 Make Autoplay work for you
Insert a USB drive, or other type of media device, into your 

machine and you’ll see Windows 10 recognises it and asks what 
you want to do with it each time. If you want to avoid this prompt, 
turn it off. Head to the Taskbar search and type Autoplay settings. 
Switch ‘Use Autoplay for all media devices’ to ‘Off’, or choose an 
action that occurs only when you insert specific media.

4 Speed up Windows with gestures
Boost your productivity levels through speedy shortcuts, 

such as dragging two fingers up or down to scroll on your 
touchpad. See which gestures are available by typing Mouse and 
touchpad into the Taskbar search and clicking the result. In here 
you can toggle gestures on or off, and you can also change what 
Windows does when you do a three-finger tap or drag and slide.
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Learn how to…
Avoid distractions  
on your computer

“Got a busy day ahead? I’ll show you how to keep  
pesky Windows 10 notifications under control  
so you can do more with your precious time”

he brain is a wonderful 
thing, capable of 
memorising many things. 

Only, it doesn’t always work that  
well in practice – some of us are  
more forgetful than others! This is 
why Windows notifications are such  
a valuable thing to have – they warn 
us of upcoming events, such as 
appointments in the calendar, new 
emails that arrive throughout the  
day and it even tells us if our 
Windows machine needs some  
kind of maintenance or app action 
that we may have forgotten to carry 
out. But sometimes you just want to 
focus your attention on one task, and 
when you’ve got Windows reminding 
you of dozens of emails that need 
checking or some other event, it can 
get in the way of what you want to 
do. Luckily, it’s easy to take care of 
notifications and minimise their 
impact on your life.

1 See new notifications
When you receive a notification, a pop-up window will 

appear above the Taskbar at the bottom of the screen. If you miss 
the alert, opening the Action Centre will allow you to view all 
notifications that you’ve received at any time by clicking the 
message bubble icon on the Taskbar. All notifications are 
displayed in a list, in order of when they appeared.

2 Check out all notifications
With the Action Centre still open, you can quickly deal with 

all open notifications by clicking the ‘Clear all’ link above. If you 
want to be a little more methodical with your approach, you can 
view individual notifications by clicking on each one – doing this 
will show you what exactly needs addressing, such as a pending 
system update or a forthcoming calendar event.

Your guide Nick Odantzis says…

T

Step-by-step Master all incoming notifications

  Anyone can do it 
Straightforward 
Tricky in parts

 Windows 10
 Windows 8.1
 Windows 7

At a glance
Skill level…

Suitable for…

Nick’s best tip
if you’re somewhere where 
privacy is a concern and you 
need to leave your pC 
momentarily, you can turn 
off notifications that appear 
on the lock screen .
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7 The power of touch
If you’re using a touchscreen PC there’s a more touch-

friendly way to turn ‘Quiet Hours’ on or off. To find this, simply tap 
(or left-click) the notifications icon in the Taskbar to open the 
Action Centre. At the bottom of this pane is a Quiet Hours tile 
– tap this to turn it on or off. If the tile doesn’t show, just tap the 
‘Expand’ setting above and to the right of the tiles.

8 That’s it!
You should now be able to take control of the way you view 

notifications on your PC! You can easily view and deal with 
notifications in the Action Centre, or turn them off in the 
notifications settings or in individual apps. Finally, ‘Quiet Hours’ 
allows you to quickly turn off notifications altogether, ideal if 
you’re in a meeting or going to sleep at night. ■

5 Fine tune notifications
If turning off all notifications bothers you, turn off 

notifications just on individual apps, keeping the ones you want 
to see. Once again, in Notifications and action settings, scroll 
down and you’ll see individual apps with a toggle switch next to 
each one, allowing you to turn them off individually. Or, click on 
one to turn on specific features, such as a notification noise.

3 Action individual notifications
To quickly deal with events that you don’t need to open for 

further information, you can hover your mouse cursor over them 
to reveal more notification controls. If you’re satisfied that you 
don’t need to know any more, click the cross next to it to dismiss 
it. If you want to quickly find out more without actually opening 
the notification, click the down-facing arrow.

6 Turn on Quiet Hours
The easiest way to avoid distracting notifications is to use 

the ‘Quiet Hours’ function. This one-click feature silences 
everything in an instant. Turn it on or off by right-clicking the 
notifications icon in the right-hand side of the Taskbar and 
selecting ‘Turn on quiet hours’ from the menu that appears. When 
you want to turn this feature off, just do the same thing again.

4 Control general notifications
If you want to control when notifications appear, you can 

alter this in the settings. Type Notifications and action settings in 
the search bar on the Taskbar, and click on this heading from the 
list that appears. Here you’ll see options that you can toggle on or 
off, such as showing tips on using Windows, app notifications and 
even being able to hide notifications during a presentation.

Explore 
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1 PRePaRations
Begin by downloading and 
installing DaVinci Resolve. It’s a 

reasonably big package at over 400MB, 
and there are a few dependencies you 
may need, although the installer takes 
care of these for you. You need to 
register in order to download it in the 
first place, and there are no nasty hidden 
extras to watch out for in the installer, as 
far as we can tell. Launch the software 
and take the tour to see a preview of a 
few of Resolve’s key features, then let it 
check your computer to see how well it’ll 
perform. You can now create a new 
project. Bear in mind the maximum 
resolution of the free version is 1080p, 
because 4K editing is locked to the 
paid-for version. The next choice is for 
the editor’s keyboard shortcuts, which 
you can set to match those of a number 
of other high-end editors – we’re using 
DaVinci’s default set, but you may be 
familiar with Premiere, Final Cut or Avid 
Media Composer.

2 look aRounD
Resolve’s interface is split into four 
parts, which you can access using 

the bar at the bottom of the window, or 
by selecting them in the ‘Workspace > 
Primary Workspace’ menu. The first one 
you’ll see is the media workspace [Image 
A], so let’s take a quick and very basic 
tour. Starting at the top-left, there’s a list 
of folder locations, which you use to 
locate your media; once a folder is 
located, a list of clips appears to its right, 
which can be previewed in the window 
to the right of that. You add your clips to 
your project by dragging them to the 
large pane at the bottom of the 
interface, or view information about the 

currently selected clip in the bottom-
right pane. Drag a few clips into the 
bottom pane, and hit [Shift]+[4] to head 
to Edit mode. 

3 the eDiting Room
Now we’re into the meat of 
Resolve’s editing facilities [Image 

B], which will be familiar to anyone 
who’s used a non-linear editor before. 
You get access to the clips you’ve 
selected, a timeline at the bottom of the 
screen, a couple of preview windows at 
the top, and a limited list of effects and 
transitions. Begin by dragging one of 
your clips onto the timeline – we’re 
using freely available public domain 
footage sourced from Archive.org, so if 
you’re looking to try Resolve, but don’t 
yet have any footage to use, that’s a 
solid legal source. When you drop your 
clip in, two tracks are created: one for 
the video, and one for its associated 
audio track. Each of these elements can 

be edited independently, although they 
begin (usefully) linked together, so your 
audio won’t end up out of sync.

4 tRim anD sPlice
Hover your mouse over the ends 
of your clip – scroll, or use your 

mouse wheel to zoom out, if you can’t 
see all of it – and you can top and tail it 
by left-clicking and dragging. While this 
is a viable tactic, it’s far from the most 
useful way to trim a clip, mainly because 
you have to keep previewing it to see 
exactly where you’ve trimmed to. Better, 
then, to splice, putting a break in your 
clip at the exact point it needs to be cut. 
Use the controls of the rightmost 
preview window to view your clip, and 
stop it at the exact point you’d like it cut. 
Alternatively, drag the red position 
marker to your splice location. Then 
select the razorblade tool along the top 
edge of the timeline pane, and click on 
the position marker to break the clip 

A

B



Video editing 
The best free tool

February 2017  |    |  65

into two. Since this is non-linear editing, 
there’s no need to worry about this 
brutality: you won’t affect your original 
files at all. Go ahead and clean up by 
selecting the arrow tool, clicking the 
excess, and hitting ‘Delete’.

5 layeRing uP
Let’s add a second clip now, and 
look at Resolve’s hierarchy. Drag 

your next clip and drop it above the 
original one, which creates a new video 
track. Overlap it with your first clip, and 
preview your video; you’ll see that the 
original has basically disappeared, since 
this new clip is at the top of the pile. This 
order matters, because it means you’re 
able to reliably mix video tracks 
together using transitions and cross 

System requirements

fades. So, let’s do that. Move your upper 
clip close to the end of the lower one, 
overlapping just slightly. Hover, using 
the arrow tool, over the top-left edge of 
your top clip [Image C] to reveal a white 
handle; drag it to the right, and drop it 
in line with the end of the first clip and 
you’ve created a cross fade. 

6 making the gRaDe
You could spend all your time in 
Resolve’s editing interface, and 

not worry about the rest of it. But 
Resolve was built as a colour-grading 
tool and, frankly, its non-linear editing 
portion is not quite as tasty as that of 
some of its competitors. The real meat, 
then, lies in the ‘Colour’ section, which 
hosts the grading, compositing, and 

effects tools. You’re working with a 
lesser collection than in the full version, 
but this is still a broadcast-standard 
selection. The only problem? The 
node-based system that Resolve uses 
can be a bit of a dog to get your head 
around. So, before we even touch the 
controls, let’s explain it with a little 
analogy. Many editors allow you to add 
effects to video using layers; think of this 
as a nice cream cake. If you’ve missed 
something out, it’s going to be a very 
messy job to pull it apart, put in the 
additional ingredient, and assemble the 
whole thing back into some presentable 
order. Using nodes is more like working 
with cupcakes; each one can be revised 
and decorated exactly as you wish; 
filling up your cupcake stand doesn’t 
mean they’re locked in place – if one 
looks a bit shoddy, you can pull it out 
without ruining the rest – and you’re 
free to eat them in any order you like. It’s 
an incredibly flexible way to add effects, 
and efficient, too. Once you’ve created a 
node, you can reuse it as you wish.

7 comPosition
So, let’s try out this section with a 
bit of green screen – otherwise 

known as chroma key – compositing. 
We’re using the clip ‘Hair Detail’ from 
www.hollywoodcamerawork.com/
greenscreenplates.html as our test, since 
it gives us a good chance to fiddle with 
some relevant settings. If you’re creating 
your own green-screen shot, make sure 
your lighting is consistent, your surface 

Resolve is not for the faint-hearted, 
and not for the faint-of-PC. It 
absolutely requires OpenCL support 
to operate, so forget about it if you’re 
looking to edit on a machine that 
doesn’t have a modern discrete 
graphics card. You’ll probably need 
to click through a couple of error 
messages when you load it, mainly 
due to Resolve looking for specialist 

editing hardware you probably don’t 
have – don’t worry about these, it’ll 
work just fine without. You may also 
find that it doesn’t play nicely with 
your monitor; we had some issues 
getting it to run on a 4K panel, and it 
needed a little convincing about our 
Windows scaling options. 

If you want to take Resolve further, 
you could consider an upgrade. The 

full version weighs in at an eye-
watering $995, and if you’re really 
serious about using it, you can pick 
up the software with a dedicated 
control surface (shown above) – 
featuring a host of buttons, jog 
wheels, and integrated LCD panels for 
fingertip control – at a positively 
eye-loosening $29,995. This really is 
one for the professionals.

C
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as flat as possible, and your camera set 
with enough saturation that the green 
doesn’t tend toward the grey. Head 
back to the timeline section, and clear it 
off by dragging a box over all the clips 
within, and hitting ‘Delete’, then place 
the green-screen footage on top of 
whatever background footage you’d like 

to use – head back to the ‘Media’ section 
to import it, if you’ve not done so 
already. If you’re using the same source 
file as us, you’ll notice that it comes as a 
series of png files. Resolve treats these 
the same as it does videos, so rather 
than importing it frame-by-frame, drag 
the folder into the bottom pane. Our clip 

has a slight issue in that it’s anamorphic, 
so it looks squashed. Select the clip in 
the bottom pane, then select ‘Clip 
Attributes’ – setting ‘Pixel Aspect Ratio’ 
to ‘16:9’ worked to pull our clip to the 
correct scale. 

8 see the Results
Head back to the ‘Edit’ section, 
and layer up a couple of clips, 

placing the green-screen footage on 
top of your background. Use the 
preview window to ensure that you can 
see the green-screen footage, then 
head to the ‘Colour’ section. Click on 
your green-screen footage to show it in 
the preview window, then add a new 
serial node by hitting [Alt]+[S]. Click the 
eyedropper tool (the Qualifier) on the 
menu in the centre of the screen, then 
click an area of green screen to select it. 
Not much seems to have changed, but 
click the sparkling magic wand icon 
above the preview, and you’ll see that 
Resolve has created a mask [Image D], 
based on your selected colour. At the 
bottom of the screen, under ‘Selection 
Range,’ clicking the rightmost icon 

Render time

Completed your video? Then it’s time to 
deliver it – or, at least, it’s time to use 
Resolve’s ‘Deliver’ section to render it. 
It’s another portion of the program 
that’s intuitive once you get the hang of 
it, but utterly alien until you do. Head 
to the ‘Deliver’ section by hitting 
[Shift]+[8], and you’ll see your timeline, 
a preview of the complete video, and a 
few more controls. When you’re happy 

with your video, choose your settings in 
the top-left panel – there are presets, 
usefully, for things such as YouTube – 
then click the ‘Browse’ button to set 
where your video will be saved. Now 
click ‘Add To Render Queue,’ and hit 
‘Start Render’ on the right-hand side. 

If you’re only using Resolve to 
process clips for use in another editor, 
use the ‘Individual Clips’ button in the 

left-hand pane to render each element 
individually. And if you’ve (sensibly) 
left small gaps at the start and end of 
your video, you can ensure it comes 
out at exactly the right length by 
changing the render to ‘In/Out Range’ 
(at the top of the timeline), and using 
the grey bar above the timeline to set 
the exact point at which you’d like 
your video to be cut.

D
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inverts the effect – because we’re 
looking to keep the foreground, rather 
than the background – and you can see 
how well you’ve done. Click and drag 
the values beneath hue, saturation, and 
luminance [Image E] in the Qualifier 
window to increase the range of colour 
you’re selecting, which should 
(hopefully) pull your chroma key much 
closer to the content you wish to keep 
visible. In our case, it hasn’t worked well, 
because the green background is 
massively over-saturated. 

9 colouRation
We need to bring that colour 
down a little before our chroma 

key will work. Right-click the second 
node in the top-right pane, and select 
‘Create serial node before.’ On this node, 
linked in the chain prior to our chroma 
key operation, we’ll adjust the clip’s 
colouration, so click it to start editing it. 

But, if we just pull out a load of green 
from the clip, our cut-out subject starts 
to look purple and unwell. But we can 
be more selective. Toward the bottom-
left, click the icon that looks like a dot 
inside a circle to find the colour wheels, 
then head to the third page. Drag the 
slider below the ‘Highlight’ wheel, and 
you’ll start pulling down the brightness 
of the background, leaving the main 
image intact. Click on the original node, 
and drag the same slider back up a little, 
which should correct any disturbance to 
the original image. Make no mistake, 
we’re hacking here. There’s no adding 
quality to poor footage, and the 
green-screen clip we’re using is supplied 
because it presents challenges; if you’re 
using your own stuff, you may not find it 
as difficult to work with. Sometimes, you 
just have to do the best job you can, 
and that means a lot of manual 
tweaking. Thankfully, pretty much every 

tool in Resolve’s Colour section has a 
reset button, so you can try your 
tweaks, and undo them quickly.

10 Qualification
Click the node with the 
chroma key applied to it, 

make sure the Qualifier tool is selected 
in the bottom-centre pane, and drag 
the blur radius to increase its value 
slightly. Don’t go crazy, but apply at 
least a small amount, which will go 
some way to offsetting the harsh lines 
often present around the edge of a 
keyed image. Now it’s time to take a 
look at our results. In the nodes panel, 
right-click, and select ‘Add Alpha 
Output,’ then click and drag a line 
between the triangular output of the 
rightmost node to the blue item that’s 
appeared. Switch off highlight mode by 
clicking the magic wand above the 
video preview, and the mixed picture 
appears. You may want to move the 
overlaid element; this is ridiculously 
easy. Just find the sizing tool on the 
central menu (third from right), and drag 
the values to move, rotate, or skew your 
overlay. The edges of the overlaid image 
block out the background, so head to 
the window tool (third from left), and 
click ‘Linear’ at the top to draw a box 
around your image, and use it [Image F] 
to clip the edges. If you have a poorly 
keyed background – perhaps with 
inconsistent green screen, or other 
elements you don’t want in shot – the 
window tool is a perfect way to get rid 
of them. So here we are – you’ve been 
given a glimpse of Resolve’s power, and 
we’ve spent four pages skimming the 
surface. Head to the ‘Help’ menu to 
open its reference manual. ■

E
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ne of the  
most stomach-
churning 
moments in 
any PC user’s 
life is when  

you switch on your computer 
to do some work or let off 
some steam, only to find 
Windows won’t boot. You may 
get lucky – Windows 10 is 
smarter than previous versions, 
and can resolve certain issues 
on its own, but in many cases, 
you’re left in an endless reboot 
loop. Assuming Windows even 
gets that far.

If Windows can’t fix itself, 
what next? Do you have a 
recent backup of your data? 
What about Windows itself? Of 
course, it’s perfectly possible to 
reinstall Windows from scratch, 
but that’s the best part of a day 

lost to restoring your PC. And 
did we mention your data?

The solution lies in creating  
a bootable recovery disc –  
one that gives you the tools  
to repair most Windows woes, 
remove malware, and lets you 
pull data off the drive in case 
you’re forced to bite the bullet 
and reinstall. In an ideal world, 
you’d be able to build a single 
rescue disc to cover all your 
needs. Linux users can smirk  
at this point, and bring out 
their Live CDs, giving them 
full-blown access to the OS 
they know and love. Wouldn’t 
it be great if you could do the 
same in Windows? The answer 
is: you can. 

In this feature, we’ll show  
you how to create all the 
recovery media you’ll ever 
need. The first disc will give 

you access to basic Windows 
recovery options, plus allow 
you to reinstall Windows if 
all else fails. The second 
offers more quick fixes to 
resolve common boot and 
loading problems, plus 
provides opportunities to 
recover files and back up or 
restore disk images. The final 
disc gives you the closest thing 
to a Linux Live CD – that is a 
fully functioning Windows-like 
environment to work in, with 
tools to help you troubleshoot 
problems, get online, and 
even add your own custom 
apps to beat malware and 
perform other tasks.

The time to create this 
media is right now, while your 
PC is still working, so turn the 
page, and protect yourself 
against disaster.

O

Build the ultimate  

WindoWs
repair  
disc

Turn panic into minor irritation by crafting  
your own customised recovery disc

Words: Nick Peers
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ur first recovery disc is 
– as it’s always been – 
the humble Windows 
installation disc. Can’t 
boot into Windows? 
Boot from this instead, 

choosing the ‘Repair your computer’ 
option when prompted. From here, 
you can attempt to fix startup 
problems automatically, launch 
System Restore to try rolling back to 
a previously working installation, or 
even restore Windows from a disk 
image. Advanced users can dig 
deeper, with access to the command 
prompt, too.

These days, most of us don’t bother 
with DVDs, so it’s unlikely that you have 
any installation media to hand. Let’s 
begin, then, by rectifying that situation. 
Start by typing recovery into the 
Cortana search box, then choose 
‘Create a recovery drive’. You’re 
prompted to back-up system files to it, 
which effectively creates a full-blown 
reinstall disc – you need an 8GB flash 
drive if you go down this route. 
Alternatively, uncheck the ‘Back-up 
system files to the recovery drive’ box, 
and make do with the basic repair 
options – in which case, all you need is 
a 512MB USB flash drive, although you 
won’t be able to reinstall Windows if 
you go down this route.

(Note: If you want to create a 
bootable DVD, you need the Media 
Creation Tool – download the latest 
version from www.microsoft.com/
software-download/windows10, and 
choose the ISO option when creating 
media for another PC, then right-click 
this file, and choose ‘Burn disc image’ to 
burn your disc.)

From here, if Windows fails to boot, 
pop in your installation disc or drive, 
and either make it your first bootable 
device in the BIOS. Or, look for an 
option to choose the boot device at 
startup, choosing the rescue media 
when prompted – note, if you’re shown 

two options (typically ‘UEFI’ and ‘USB’), 
choose ‘UEFI’. From here, you can follow 
the prompts to hopefully  bring your PC 
back to life, or – if all other avenues fail 
– reinstall Windows from scratch.

Beyond  
the  
Basics The Windows repair 

tool is all well and 
good, but there  
are times when it 

can’t help. It can’t disinfect your 
malware-infested drive, for example, 
and neither can you easily copy files 
from a badly mangled Windows 
installation, before formatting the drive, 
and starting again. If you want to 
protect yourself against either of these 
two possibilities, you need to augment 
it with something else. 

Most anti-malware vendors offer a 
recovery-disc solution that specialises in 
rooting out malware – see the box 

O

opposite for details about creating a 
fourth recovery disc if you decide 
against the full-blown Live CD option 
later on in this feature. In the meantime, 
our second recovery disc takes things 
one step further than the Windows 
install disc. Lazesoft Recovery Suite 
Home Edition is free (for non-
commercial use), so start by 
downloading and installing it from 
www.lazesoft.com/lazesoft-recovery-
suite-free.html.

Lazesoft Recovery Suite contains four 
key components, all of which can be 
run directly from Windows (even in Safe 
mode). Of course, we’re interested in 
building recovery boot media, so after 
launch, click the ‘Burn CD/USB Disk’ link. 
You’re asked to specify the target 
version of Windows – leave the default 
‘DO NOT specify’ setting applied for 
Windows 10 support, then click ‘Next’. 
Choose your target media: CD/DVD, 
USB, or ISO file, then click ‘Start’. Once 
created, check out the box over the 
page to find out what sort of problems 
Lazesoft can attempt to fix.

onWard 
and  
upWard Lazesoft Recovery 

Suite is well worth 
using in case it can 
fix your problem 

with just a few clicks, but what if it 
can’t? In an ideal world, you’d be able 
to boot into a more complete Windows-
like environment – one that employs 
the familiar point-and-click interface, 
while giving you access to a wider 
range of tools, full internet access 
(being able to research error 
messages online could be a crucial  
step toward solving your problem), and 
more besides.

The good news is that all of this is 

Your options are 
somewhat limited in 

Windows’ own rescue 
environment.

Win10PESE provides you with a recovery environment based on Windows.
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possible – Microsoft produces a 
specialised version of Windows called 
Windows PE, with ‘PE’ standing for 
‘Pre-installation Environment’. It’s 
designed to be run directly from 
removable media, and has been 
adapted over the years by various 
individuals to provide recovery discs 
that can give you the best of all worlds 
– think Bart PE (based on Windows XP) 
and AOMEI PE Builder (Windows 7 or 8, 
but not 8.1 or 10).

One of the most successful PE-
building tools is WinBuilder, and one 
user-friendly variant for Windows 10 
comes in the form of Win10PESE. It’s a 
flexible custom recovery tool builder 
that enables you to incorporate 
additional apps and tools if you need 
them, and can be burned to DVD or USB 
flash drive (1GB or larger).

Build a 
custom 
recovery 
disc

Start by visiting 
http://win10se.
cwcodes.net/
Compressed/, and 

click the link under the ‘Package’ 
column to save the recovery builder tool 
in zip format to your hard drive. Once 
done, right-click the zip file, and choose 
‘Extract All’, then open the Win10PE_
SE_<date> folder (the <date> 
corresponds to the latest build number), 
and double-click ‘BuilderSE.exe’ to get 
started. The WinBuilder main screen 
reveals all the basic steps that you need 
to follow.

One of those steps involves giving the 
builder access to Windows 10 
installation media – sadly, your recovery 
drive (or a disc created using the Media 
Creation Tool) doesn’t count. Instead, 
click the ‘Microsoft Windows and Office 
ISO Download Tool’ link in WinBuilder to 
access a tool that downloads the 
Windows 10 ISO. Once downloaded, 
launch the app, select ‘Windows 10’, 
then choose the ‘Windows 10 Home/
Pro’ link from the drop-down menu, 
before clicking ‘Confirm’. Choose your 
language, click ‘Confirm’ again, then 
pick the 64-bit or 32-bit download, 
based on which version you currently 

Malware recovery discs
One of malware’s 
nastiest tricks is to 
cripple your PC so it’s 
impossible to clean. The 
malware suppresses 
known security tools 
from running, plus locks 
down your system in 
various ways, such as 
restricting which 
websites you can visit, 
barring access to 
Registry Editor, and 
even crippling Safe 
mode, inside which 
most anti-malware  
tools can attempt to 
clean up the mess.

The solution here lies 
in visiting your security 
vendor’s site to locate 
recovery media that 
includes a special 
version of your anti-

malware product that 
has network access to 
update itself, then 
focuses on detecting 
and cleaning malware. 
Depending on the tool 
and the infection, you 
should find any 
collateral damage has 
also been repaired, 
although tools such  
as Windows Repair 
(www.tweaking.com) 
and Complete Internet 
Repair (www.rizonesoft.
com) can be used in 
Windows proper after 
the malware has been 
scrubbed, if this doesn’t 
prove to be the case.

These tools are free. 
Just download the ISO 
file to the hard drive of 
a clean, working PC, 

then right-click it, and 
choose ‘Burn disc image’ 
to burn a DVD from it, 
or use a tool such as 
Rufus (https://rufus.
akeo.ie) to create a 
bootable USB flash drive 
from the ISO’s contents, 
if the vendor in question 
doesn’t provide a live 
CD/USB creation tool.
Major anti-malware  
vendors offering 
bootable recovery discs 
include Kaspersky 
(https://support.
kaspersky.co.uk/4162), 
Norton (https://security.
symantec.com/nbrt/
nbrt.aspx), ESET (www.
eset.com/int/support/
sysrescue), and AVG 
(www.avg.com/ww-en/
download.prd-arl).

have (press [Win] + [Pause/Break] to find 
out if you’re not sure), to download the 
ISO file.

Next, double-click the ISO file to allow 
Windows to mount it as a virtual CD/
DVD drive (it’ll be visible in File 
Explorer). Now return to Win10PESE, and 
click the ‘Source’ button. Click the folder 
button under ‘Source Directory’ to 
select the virtual disc drive.

In the program’s left-hand pane, you’ll 
see a number of collapsible folders that, 
when opened, revealed additional 
settings. If you’re in a hurry, you can skip 
all of these to generate a basic, but 
usable, ISO file – just click the play 

button, sit back, and wait for the disc to 
be created. Once complete, look inside 
the Win10PE_SE_<date>\ISO folder for 
the ISO file you can subsequently burn 
to disc, by right-clicking the file and 
choosing ‘Burn disc image’.

If you’re creating a bootable USB 
recovery drive, however, you should 
take the time to expand the 
‘WriteMedia’ section. If your PC has a 
64-bit UEFI (check with the 
manufacturer), select the ‘Copy to 
USB-Device’ box; if not, select ‘Copy to 
USB-Device BCD Bootloader’ instead, 
and check ‘Add Grub2-EFI (x64 UEFI 
only)’ to ensure it boots. Click the 

It can take a while to build your customised 
recovery disc.
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Fix Windows boot problems
Lazesoft Recovery Suite 
offers a number of 
handy tools for fixing 
problems with 
Windows, plus it can 
help you recover data, 
too. Once created, 
reboot your PC from the 
Lazesoft rescue media. 
You’ll eventually find 
yourself at the main 
Lazesoft Recovery Suite, 
with four recovery-
based options: 
‘Windows Recovery’, 
‘Data Recovery’, ‘Disk 
Image & Clone’, and 
‘Password Recovery’.

All four options are 
largely self-explanatory. 
Before running any 
recovery tools, we 
recommend taking a 
drive image of your 
current setup, which 
ensures you can always 
roll things back should 
the cure prove worse 
than the malady. Select 
‘Disk Image & Clone’, 

and choose ‘Drive to 
Image’ to back up to a 
suitable external drive. 
Second, ‘Data Recovery’ 
contains the full range 
of data recovery 
options, including 
pulling off regular files, 
as well as searching for 
lost and deleted files 
and partitions. 

‘Windows Recovery’ 
attempts to fix your 
boot problems, offering 
a wide range of options 
across a series of tabs. 
There’s also a one-click 
solution if you’d prefer 
the software to try to 
diagnose and repair on 
its own, with an ‘Undo’ 
button that promises to 
reverse any changes 
made if the problem 
isn’t fixed or gets worse. 

If this fails, try the 
other options: 
‘BootCrash’, 
‘LoadingCrash’, and 
‘RandomCrash’. Each 

one steps you through  
a series of potential fixes 
to try, from repairing 
the MBR and restoring 
missing or corrupted 
files, such as Ntosknl.exe 
(‘BootCrash’), to running 
memory diagnostics, 
and recovering  
the Registry 
(‘RandomCrash’).

The final tool – 
‘Password Recovery’ – 
promises to reset your 
Windows password if 
you’ve forgotten it, plus 
can reveal your 
Windows and Office 
product keys, should 
you need them. The 
former option only 
works with local 
passwords – in other 
words, if you sign in to 
Windows using your 
Microsoft Account, you 
need to visit https://
account.live.com/
password/reset to try to  
fix the problem.

folder button under ‘Please select the 
root directory of your USB-Device’, to 
select the correct drive letter if 
necessary, then click ‘Copy to USB’ to 
build your recovery drive from the ISO 
you just created.

take it 
for a  
test drive

You can now test 
the recovery drive 
by booting from it in 
the same way you’d 

boot from the previous two recovery 
options. A menu appears – select 
‘Win10PESE’ to boot into your recovery 
environment. When the desktop 
environment pops up, you’re prompted 

to choose your network connection 
type, if one is detected – the default 
DHCP is automatically selected after a 
five-second pause.

You then find yourself at a close 
approximation of the Windows 10 
desktop, albeit one employing a more 
‘classic’ Windows look and feel. You’ll 
see convenient shortcuts to File 
Explorer, the Command Prompt, and 
PENetwork on both the Taskbar and 
desktop – there’s also a shortcut to 
Firefox, giving you access to the web. 
PENetwork merely launches the 
network manager, which should already 
be running and accessible from the 
Taskbar Notification area, alongside 
other controls, including one that 
enables you to set a different desktop 
resolution if you wish (note this feature 
doesn’t work very well on UEFI systems 
– you’re likely to find only the 
1920x1080 and 1024x768 options work).

Click the ‘Start’ button, and select ‘All 
Programs’ to see what tools and utilities 
are included with the vanilla Win10PESE 
disc – shortcuts to critical Control Panel 
and system management applets are 
included, as are a handful  
of file-related tools (including 7-Zip), 
BootICE (for managing the boot 
manager), a PDF viewer, and some 
handy system tools, including  
Remote Regedit (for manipulating  
your Registry in case your boot 
problems stem from there), as well as 
access to the System Recovery options 
found in Windows itself.

These tools are all welcome and 
helpful, but you may be hankering  
after different tools and utilities –  
you may even simply want to be able  
to run a particular app, such as a word 
processor, while you try to fix your  
boot problem. The good news is that 
your Win10PESE environment can 
support third-party applications and 
programs, too. 

We say ‘some’ because, while certain 
program installers work, on the whole 
you’re limited to portable apps, namely 
those that run directly from a folder. 
You can download these from the 
internet (look under X:\Users\Default for 
the Downloads folder), but be sure to 
copy portable apps and key files to 
another drive if you want to keep them 

Lazesoft provides a wide range of data 
recovery tools.
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Add apps to your drive
Why plug in another 
USB drive, or download 
tools from the net, 
when you can embed 
any portable tool 
directly into your 
recovery drive? Once 
embedded, the tools 
can be directly accessed 
through Win10PESE’s 
Start menu, or via an 
icon in the Taskbar 
Notification area.

To add apps to your 
drive, first expand the 
‘Apps > Portable’ 
section in Win10PESE’s 
left-hand pane, then 
check ‘PStart and 
Papps’. Next, click the 
‘Open Source Folder’ 
button to open the 
folder where your 
portable apps need to 
be collected, each inside 
its own folder. Once 
you’ve copied them into 

here, return to 
Win10PESE, and enter 
the folder name of each 
app under ‘Directory of 
Apps’, plus the name of 
the program’s 
executable file under 
‘Name of exe’. 

To add a shortcut to 
the Start menu, check 
‘Start menu’, and then 
specify the folder (get 
this from Projects\
Win10PESE\Apps), and 
shortcut name; you can 
add a desktop shortcut, 
too, by checking the 
appropriate box. Finally, 
if you’re burning a DVD, 
be sure to select ‘Run 
from RAM’ to allow any 
anti-malware  tools to 
download and process 
updates. Then create 
the disc in the usual way.
What sort of portable 
apps should you be 

looking to add to your 
toolkit? Two 
recommended anti-
malware  tools are 
Emsisoft Emergency Kit 
(www.emsisoft.com/en/
software/eek), which 
utilises two anti-
malware  engines, and 
Malwarebytes Junkware 
Removal Tool (www.
malwarebytes.com/
junkwareremovaltool) 
for PUPs.

Piriform (www.
piriform.com) provides 
portable versions of 
CCleaner (cleanup tool), 
Recuva (data recovery), 
and Speccy (system 
information). Another 
data recovery tool 
worth adding is DMDE 
Free (https://dmde.com), 
while a wide array of 
tools can be found at 
www.portableapps.com.

for another session – the ‘X’ drive 
resides only in memory, which means 
it’s wiped the moment you reboot.

Bring  
your  
oWn Luckily, you have  

a number of options 
should you wish  
to build up a more 

permanent collection of tools and 
utilities. Portable apps can be stored  
on another drive – a USB flash drive,  
say, or shared network folder. Access 
them via the Windows PE environment 
when needed.

A more elegant solution, and one that 
incorporates your applications directly 
into your recovery drive (with shortcuts 
through the Start menu), is to follow the 
‘Add apps to your drive’ box on the 
right. Also take the time to explore 
some of the other options that 
Win10PESE provides. Explore the 
various sections of the disk-creation 
tool; expand ‘Shell’, for example, and 
you can change the packaged Start 
menu, plus configure its appearance. 
Expand ‘Components’, and you can 
choose which Windows tools and 
accessories to include – add the .NET 
Framework to support a wider range of 
applications, for example.

If you have a virtual Windows 
machine to hand using a tool such as 
VirtualBox (www.virtualbox.org), use it 
to test your recovery disc – open 
‘VirtualTest’, and select ‘VirtualBox 
Emulation’ to set up a dedicated virtual 
machine to test the ISO file with. It’s a 
great way to check to see what effect 
your tweaks have, without having to 
recreate a USB flash drive or boot from 
your PC each time. But do remember to 
test the final disc or drive on your actual 
PC when you’ve got it working to your 
satisfaction, to make sure.

trouBle-
shoot 
your pc Your recovery discs 

have been created, 
waiting for the time 
they’ll be needed. 

Now your PC is refusing to boot, and 
you’ve whisked out your recovery discs. 
What to do? First, we recommend 
taking a drive image of the system 
partitions before you start attempting 
to fix things. Use Lazesoft for this task, 
unless you have an emergency boot 
disc coupled to your existing system 
imaging tool (such as Macrium Reflect 
Free), in which case use that.

With the drive image in place, you 
can start to attempt a fix for your 
problem. Begin with your Windows 
installation disc, to see if its Automatic 
Repair tool can get Windows up and 
running again. Make a careful note of 
any error messages if the problem 
persists, then move on to Lazesoft’s 

Windows Recovery component (see  
the box on the previous page). If 
Lazesoft’s fix-it tools fail to fix your 
loading problems, bring out the 
Win10PESE disc. Boot from this, then use 
the tools onboard  – such as Remote 
Regedit – to try to fix known problems. 
Don’t forget your internet connection 
– use Firefox to browse for possible 
solutions to error messages, plus 
download additional software you 
might need, but didn’t include on the 
disc. This is particularly handy if you’re 
battling malware infections – you can 
track down specific removal tools, or 
locate your vendor’s portable scanning 
toolkit, should our other suggestions 
fail to yield results.  n

Win10PESE enables you to run portable apps from 
other drives.
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Security
HOW TO ENcRyPT  
my USB FLASH DRIvE? 

Q I have recently bought  
a Sony laptop and want to 

password-protect my USB memory 
sticks that I’m going to use with it. 
However, I can’t seem to find 
BitLocker on my laptop (which is 
running Windows 10). Is there a 
good alternative? Any advice would 
be gratefully received!
John Hollingsworth

Graham’s solution
BitLocker only comes 
with Windows 10 
Professional, but 

thankfully there are plenty of 
alternatives out there. Assuming 
you’re looking for something free, 
then DiskCryptor (https://
diskcryptor.net) would enable you 
to encrypt the entire flash drive, 
although it can be tricky to install 
and set up. In most cases, you’re 
only looking to encrypt particularly 

sensitive files, in which case Rohos 
Mini Drive (www.rohos.com)  
would offer a more user-friendly 
alternative. The free version allows 
you to create a hidden and 
encrypted storage container up to 
8GB in size, which should be ample 
for most people’s needs, and it 
doesn’t delete existing files on the 
drive either.

Email
WHy cAN’T I LOG  
INTO HOTmAIL vIA 
THUNDERBIRD 

Q I hope you can help. I’ve tried 
switching from Windows Live 

Mail to Thunderbird, but can’t get it 
to recognise my Hotmail password, 
even though it’s correct. Can you 
advise, please?
Ursula Franklin

Graham’s solution
We eventually traced the 
problem to the fact that 
Ursula has two-step 

verification enabled for her 
Hotmail account. This sensible 
security step means that she needs 

Do you have a  
PC problem?  
Get in touch…
Email full details of your 
problem to the 
support team and we’ll 
do our best to help 
windowsmagazine@
futurenet.com

Safe Space Rohos 
Mini Drive allows 

you to encrypt 
your flash drive.
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to confirm any attempt to log on to 
her Hotmail account from a new 
device or program, but 
Thunderbird doesn’t support this. 
Luckily, there is a workaround that 
ensures she doesn’t have to disable 
the feature. First, log into your 
Microsoft Account via https://
account.live.com – once logged in, 
select ‘Security & privacy’ and click 
‘More security settings’ under 
‘Account security’. Scroll down to 
the ‘App passwords’ section and 
click ‘Create a new app password’. 
Select the app password that’s 
generated and press [Ctrl]+[C] to 
copy it to the clipboard, then 
switch back to Thunderbird and use 
that password in place of your 
regular password – you should find 
you’re now able to access Hotmail.
Going forward, you’ll need to 
create a new app password for each 
device or app that doesn’t support 
two-step verification.

Multimedia
REGION-LOckED  
DvDS WON’T PLAy 

Q I have a US laptop set to 
play Region 1 discs and 

recently purchased a few UK DVD 
boxsets. I’ve been trying to 
bypass region-coded discs by 
playing them in VLC Media Player, 
but, while some work, others 
throw up errors such as ‘VLC cannot 
set the DVD’s title’. Can you provide 
a workaround at all?
Nathaniel Aharon

Nick O’s solution
Our first suggestion was 
to install DVDFab 
Passkey Lite (www.

dvdfab.cn/passkey-lite.htm), which 
can bypass region encoding and 
allow you to play most region-
locked DVDs through any DVD 
player, including VLC Media Player. 
This fixed our problem, but 
Nathaniel reported it ended up 
disabling his drive altogether – he 

had to remove the software and 
delete a Registry key to get things 
working again.

This could be down to the 
presence of other third-party DVD 
software interfering with the 
process, but a simple, catch-all fix 
would be to purchase a slim 
external DVD drive for around 
£20-25. Each drive can be set to a 
specific region, so the internal drive 
could be left to play native DVDs 
while the external drive is used 
exclusively to play Region 1 discs.

Windows 7
cAN’T GET WINDOWS 7 
TO UPDATE 

Q My wife’s slow netbook has 
not updated for almost a 

year, and the setup log has several 
lines reading: ‘Error 41227 – 
Downloader system error has 
occurred’. I’ve tried everything to 
correct this – including following 
the advice in issue 125’s Support 
Squad, but I can’t get it to work. 
Can you help please?
Bill Skidmore

Quickfire questions

Find the solution! Microsoft Bug Check Code Reference
Visit http://bit.ly/bugcheck for a comprehensive list of Stop  
Code errors – click a name for more information on that error.

I accidentally moved the 
wrong application using Steam 
Mover as outlined in issue 129’s 
Support Squad. How do I 
reverse this?
Benny Deacon

Just select the program in the 
list, then click the back arrow at 
the bottom of the screen to 
move it back.
 
Is there a quick way to remove 
a batch of Tweets from Twitter?
Stuart Linklater

Try www.tweetdelete.net, 
which allows you to delete all 
Tweets older than a certain 
date (from one week to one 
year). Use its Tweet Download 
service to save them locally 
before erasing.

“Passkey Lite allows you 
to play region-locked 
DVDs through any player”

 BitLocker 
A file-encryption tool found in 
Professional and Enterprise 
versions of Windows. It’s used 
to encrypt entire hard drives as 
well as USB flash drives.
 

 BSOD
Stands for ‘Blue Screen of 
Death’ and refers to STOP 
errors that halt the computer, 
forcing a restart. 

Region fix 
purchase a 
secondary DVD 
drive to play 
region 1 discs.

DelVe Deep  
See what’s running 

on your pc  
using HijackThis!

Support 
Technical help
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2 Set universal limits
Now, tick ‘Deny disk space to users 

exceeding quota limit’ and select ‘Limit disk 
space to’. Set your chosen limit (probably in 
GB) – we also recommend setting a warning 
limit, around 10-20% less than the limit 
you’ve picked.

1 Enable Disk Quotas
Quotas must be set individually  

for each hard drive. Open ‘File Explorer >  
This PC’, right-click the drive in question  
and choose ‘Properties > Quota’ tab. Click 
‘Show Quota Settings’ and start by ticking 
‘Enable quota management’.

LImIT STORAGE SPAcE TO 
SPEcIFIc USERS

Q I enjoyed your article in  
issue 128 about reclaiming 

ownership of your PC. One of 
my family members keeps filling 
up the hard drive – is there some 
way to put a limit on that? 
Don Taylor

Nick P’s solution
The answer to your 
dilemma lies with the 
Disk Quotas tool, which 

allows you to specify the maximum 
amount of storage space each user 
has on each attached drive. Here’s 
how to set it up.

Quickfire questions

Windows
BLUE-ScREEN ERRORS 
ARE PLAGUING my NEW 
WINDOWS INSTALL 

Q For a long time now, 
whenever I start or restart  

my Dell XPS 8700 PC (running 
Windows 10) I get an immediate 
BSOD referring to NETIO.SYS and 
with the following Stop Code: 
Kmode Exception Not Handled. The 
computer then attempts to fix the 
problem and after several reboots 
Windows will load. I’ve come across 
the same error on another PC we 
own, but this only occurred once. 
I’ve tried rolling back to a system 
image and numerous clean 
reinstalls, all with no success. 
Hopefully you can save me the cost 
of a new PC!
Jim Thomas

Nick P’s solution
The netio.sys file is a 
generic Windows one, 
so there were no clues 

there. We asked Jim to send us his 

I need to perform multiple 
edits to a group of photos. Is 
there a free tool that can 
simplify this process for me?
Ann Renard

imBatch (www.highmotion 
software.com) is a batch-
processing tool that utilises a 
Task Structure to allow you to 
combine multiple edits into a 
single taskflow, then simply 
select which images you want 
to apply those edits to.
 
If I switch to signing in using a 
Microsoft Account, what 
happens if my PC is offline? 
Will I still be able to sign in?
Gordon Lees

Yes, but note that if you 
change your Microsoft Account 
password on another device 
before you next go online with 
your PC, you’ll still need to log 
on using your old password.
 
I’ve upgraded to the Vivaldi 
web browser, but although  
I’ve paired my Philips Hue  
hub to it, I can’t link in my 
lights to the browser?
Paul Querry

Vivaldi introduced support for 
using Philips Hue lights in 
version 1.5, but it currently only 
works with coloured bulbs, 
which change colour based on 
the colour scheme of the 
website you’re visiting.

matt’s solution
The key is getting 
Windows 7 up to date 
– at some point over the 

past year, a problem with slow and 
malfunctioning updates was 
addressed. The best way to do this 
is by downloading the updated July 
2016 update rollup for Windows 7 
SP1 from https://support.microsoft.
com/kb/3172605 – make sure you 
download the correct package for 
your system type (x86 for 32-bit, 
x64 for 64-bit).

Once downloaded, click ‘Start > 
Run’, type services.msc and click 
‘OK’ to open the Services 
management console. Locate the 
Windows Update service, right-click 
it and choose ‘Stop’. Now double-
click the downloaded package and 
wait for it to run – there will be a 
lengthy delay, but be patient and it 
should move on to install the 
updates. Once complete, reboot 
your PC when prompted and you 
should find Windows Update is 
now working correctly again.

in Sync emclient 
keeps cloud 
calendars and 
email in sync.
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 ImAP 

Stands for ‘Internet Message 
Access Protocol’, and is a form 
of email that leaves messages 
on the server when accessed 
to allow easy retrieval from 
multiple devices.
 

 Two-step verification
A form of security that requires 
users to enter an access code 
they receive on a secondary 
device (such as a phone) as an 
extra form of identification 
when logging into a service. 

4 Set quota
Select a name from the list (they must 

have a user on your PC) and click ‘OK’ twice. 
Set their quota and warning limits as 
required, then repeat for other users you wish 
to apply limits to. Once done, close the 
window and click ‘OK’ twice.

3 Set individual limits
To set the limits for any individual 

users, simply leave ‘Do not limit disk usage’ 
selected and click ‘Quota Entries’ instead. 
Then select ‘Quota > New Quota Entry’. Click 
‘Advanced’ followed by ‘Find Now’ to list all 
available users.

“Traditional headphones that connect via  
a phono plug to your computer won’t  

show up in Device Manager”

HijackThis! log to see what was 
running on his PC – he revealed 
that AVG Internet Security was 
installed, and our Google searches 
for the netio.sys error did turn up 
one that was linked to AVG. Jim 
dutifully uninstalled the program 
and the BSOD errors immediately 
ceased. We dug a little deeper and 
found numerous references to 
AVG causing this kind of error, so 
Jim has subsequently switched 
antivirus products – Avira (www.
avira.com) is one that currently 
scores highly for those looking for 
free protection.

Internet
cAN’T SyNc cALENDAR 
IN WINDOWS LIvE mAIL 

Q We’ve had sync problems 
with a Hotmail mail account, 

so converted it to ImAP protocol 
for use in Windows Live Mail, not 
realising the calendar would no 
longer function. What’s the best 
solution for a Windows 10 
desktop, Windows 7 laptop and 
Android tablets – we need a 
calendar that syncs between all of 
them? Thanks!
Tim kaye

cat’s solution
By the time we got 
in contact, Tim had 
already switched to 

a Google calendar, which synced 
seamlessly on his Android 
devices. Now he was trying to 
keep it in sync using Thunderbird 
and its built-in Lightning calendar 
add-on. Results were mixed, 
and so we steered him towards 
the free version of emClient  
(www.emclient.com), which 
supports up to two email and 
calendar accounts. Tim was 
pleased at how easy it was to set 
up and sync, and has now moved 
exclusively across.

Hardware
cAN’T USE HEADPHONES 
IN WINDOWS 10 

Q I recently purchased a new 
Lenovo PC to replace my dead 

Advent, but have discovered that I 
can’t use my headphones. My 
speakers work normally, but there’s 
no sign of my headphones under 
‘Device Manager’ or ‘Devices & 
Printers’. I’ve tested them using the 
TV and they work fine, but there’s 
no luck when plugged into either 
front or rear port on the PC.
John colton

mayank’s solution
The fact you’ve tested 
them in your TV makes 
us think they’re 

traditional headphones that 
connect via a phono plug to your 
computer. If this is the case, they 
won’t show up in ‘Device Manager’. 
Instead, you need to check the 
Taskbar Notification area for a 
speaker-like icon, which you should 
click or right-click to open the 
sound manager. You should see a 
list of audio ports appear – plug in 
your headphones and the sound-
manager tool should detect the 
presence of the headphones, 
allowing you to test if they work 
and verify the settings are correct. If 
you have purchased USB 
headphones, you need to visit the 
manufacturer’s web page to verify 
they’re compatible with Windows 
10 and download any drivers. ■

DeTecT anD TeST 
Use your pc’s 
sound manager 
tool to check your 
headphones.

Do you have  
a PC problem?  
Get in touch…
Email full details of 
your problem to the 
support team and we’ll 
do our best to help: 
windowsmagazine@
futurenet.com 
Or write to the support 
team and we’ll do 
our best to help: 
Support Squad, 
Windows Help & 
Advice magazine, 
Future Publishing Ltd, 
Quay House, The 
Ambury, Bath  
BA1 1AU

Support 
Technical help
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 WindoWs 10 tips   features explained   neW tips and tricks

Welcome
Just starting your 
Windows journey? 
Stumbling over  
the changes made 
in the recent 

Anniversary update? Or 
maybe you just want to 
learn something new about 
Windows 10. This is the 
section for you!

There’s not enough space to 
tell you absolutely everything 
you need to know here, but 
Windows Help & Advice always 
has your back. In this month’s 
Explore section, we help you 
take control of the Start Menu, 
so you can customise it to your 
every whim. We also show you 
how to get more from the 
Action Centre. 

Matt Hanson  
Associate Editor 

Featuring…

Windows 10 tip of the month Lock screen settings

The sign-in screen in Windows 10 is 
known as the Lock screen, because your 
comptuer is effectively locked until you 
sign in with a correct password. You can 
actually change quite a few of the things 
that happen on the Lock screen once 
you access the correct settings, 
including the background image, the 
apps that can show their status, and the 
amount of time to wait before turning 
off your screen.

Change the Lock screen background

Windows 10

lock screen settings open the settings app then 
type in ‘lock screen settings’ in the search bar.

cHange settings  Here you can change the lock 
screen image and also the time it takes to activate.

Welcome to…

www.facebook.com/windowsmag

Turn To  
page 58 
To fix 

windows 
annoyances
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1 The new Start menu
Click the Start button to view the updated Start menu. 

The main changes are to the left-hand portion of the menu, as 
our annotated screenshot reveals. Now all your installed 
programs and apps are no longer hidden behind the ‘All apps’ 
sub-menu, and can be found underneath the ‘Recently added’ 
and ‘Most used’ lists, which remain in place.

2 Speed up app launches
When you click the Start button, the Cortana search box 

is immediately highlighted – you can then start typing the name 
of the program you wish to launch and it’ll appear in the list, 
saving you the hassle of wading through the full ‘All apps’ list. The 
search is smart too – type ‘office’ for example, and it’ll list 
associated Office apps such as Word, Excel and PowerPoint.

Hamburger
Click the hamburger-
like icon to show or 
hide the titles of 
the buttons in the 
left-hand column. 

Sign ouT 
quickly
Click your  
user picture  
to access the 
account menu 
previously found 
at the top of the  
Start menu. 

oTHer 
SHorTcuTS
These icons give 
you access to File 
Explorer, Settings 
and the Power 
button – put user 
folders here too.

O
Time Taken
10 minutes

ne of the changes in  
the latest version of 
Windows 10 is that the 
Start menu and Taskbar 
have been updated. 
While the changes are 

visible the moment you click the Start 
button, they’re not as radical as you 
might think. Behind the intuitive 
redesign, which makes certain popular 
features like the ‘All apps’ menu more 
accessible, the Start menu continues to 
work as it’s always done since its 
heralded return to Windows 10.

Here, we look at the Start menu 
changes, plus we’ll take a look at how 
the Taskbar has evolved too.

Take charge of  
the Start menu

Learn how to…

How to master the Start menu

Harness the Start menu and  
Taskbar in the latest Windows 10
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3 browse ‘all apps’ quickly
Alternatively, speed up browsing by clicking the ‘Recently 

added’ header to reveal an A-to-Z list, and click a letter to jump 
to that letter in the apps list. You’ll also see a clock icon – select 
this to jump back to the top of the list. Right-click an app entry to 
access the same options as before, including the ‘Don’t show in 
this list’ option if you want to trim the apps list back.

4 chaseable live tiles
One big change to the way Start menu tiles behave is 

they can now be coded as ‘chaseable’ by the app developer. This 
means that if they’re displaying live content like a news headline, 
then clicking the tile will take you directly to the content rather 
than the app’s main screen. This requires app support – at time 
of writing, MSPoweruser is one such app.

all-in-one
The new Start menu 
now lists All Apps  
on the main screen 
beneath the recently 
and frequently  
used lists.

reSize
As before, adjust 
the number of tile 
columns by clicking 
and dragging on the 
right-hand edge of 
the menu to expand 
or contract. 

TileS
Your previous tiles 
remain untouched – but 
look out for an increased 
number of suggested 
apps (or ads). 

Welcome to Windows 
Take charge of the Start menu
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9 new Taskbar settings
Previously the Taskbar settings were split across three 

tabs – now they’ve all been merged into one section, with the 
options mixed up. One new setting allows you to hide the taskbar 
when in Tablet Mode, while there’s a new ‘Multiple displays’ 
section that enables you to configure how the taskbar behaves 
when you’ve spread your display over two or more monitors.

7 Taskbar tweaks
The only real visible change to the Taskbar is the new 

Notifications button, which now sits on the far right and 
displays the number of unread notifications it contains (see 
page 38 for a tutorial). There’s also a new Windows Ink option 
when you right-click the Taskbar. Ticking this reveals a pen-like 
button – click it to bring up the new Windows Ink Workspace.

5 Start menu icons
The left-hand column displays four icons. Click the user 

photo for sign-out options, and right-click File Explorer for 
Quick Access shortcuts and a ‘More’ sub-menu with options for 
‘Computer Management’ and ‘System Properties’. Go to ‘Start > 
Settings > Personalisation > Start to add user folder shortcuts 
here’ to add other user folder shortcuts.

10 customise the Notification area
You’ll also find a shortcut to choosing how programs’ 

Taskbar notification icons are displayed – this has been moved 
from its old location under ‘System > Notifications & actions’. A 
simpler way to customise how these icons behave is to drag and 
drop them to and from the Taskbar (using the hidden area that 
appears when you click the ^ button to the left of the icons). ■

8  Tweak Taskbar settings
The Anniversary Edition moves Taskbar settings from 

their own pop-up box to a Taskbar section inside the main 
Settings app, which you’ll find under ‘Personalisation’ adjacent to 
the settings for tweaking the Start menu. The quickest way to 
access the Taskbar portion of Settings is by right-clicking the 
Taskbar and selecting ‘Settings’, which takes you to it.

6 Tablet mode changes
The Start menu’s appearance has changed in Tablet Mode 

too, and it now more closely resembles the old Windows 8 Metro 
user interface. Pinned tiles are shown by default, but you can 
quickly switch to ‘All apps’ view with one click, while once again 
the options on the left have been reduced to single buttons – 
click the ‘hamburger’ icon to expand them and reveal their titles.
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Stay notified in 
Windows 10

Discover how to take advantage of the Action Centre’s 
improved notifications system

2 Notification banners
Pop-up notifications – known as toasts – display useful 

information. They’re capable of displaying ‘richer’ information, 
such as message details, the app icon and even pictures. As 
before, click on a pop-up notification to respond directly to it or 
the ‘x’ button to dismiss it. Alternatively, you can ignore it and it’ll 
be added to the list in the Action Centre.

T
he Action Centre is a 
vertical pane that appears 
at the right-hand side of 
the desktop when you 
swipe in from the right or 
click (or tap on a tablet) 

on a button in the notification tray. It 
combines the function of several previous 

Windows features, such as Charms, to 
provide you with one place where you 
can get your notifications, access 
commonly needed functions like WiFi and 
security, and Airplane mode for silencing 
your PC and cutting all connections. 

The Action Centre had a big makeover 
in Windows 10, and the Anniversary 

Edition sees some welcome refinements 
that make it even more configurable, 
customisable and helpful. 

One particularly clever new feature is 
the ability to sync notifications between 
your Windows-powered devices. Join us 
for a tour of your Action Centre, starting 
with how to access it. 

1 A new icon
The new Notifications icon has moved to the far right of 

the taskbar, and while the basic design (a speech bubble) hasn’t 
changed, the icon now updates to show how many unread 
notifications you have. When you click to review these, the 
speech bubble will empty to indicate the notifications have 
been acknowledged – see Step 3 for details on reviewing these.

Stay on top of notifications

3 Action Centre redesign
The Action Centre’s look has also been updated in the 

Anniversary Edition, along with its functionality. Notifications are 
now grouped by Sender, with the app icon shown here rather 
than next to individual updates. You can now view more unread 
notifications per app and not just the last three received – click 
the ‘See more’ link underneath the notifications to view them all.

4 Wider notification support
You can now receive notifications from other sources 

such as Cortana’s notebook. For example, browse to ‘Notebook > 
Sports’ and tap on a team you’re tracking, then tick ‘Notify me of 
the final score’. The same is true of Edge – if you’re using certain 
websites that support notifications like web.skype.com, then 
you can get toasts while the site is open in a browser tab.
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7 Customise Quick Actions
You can now rearrange the order of your Quick Action 

buttons – click ‘All Settings’ and navigate to ‘System > 
Notifications & actions’. Click and drag buttons to rearrange 
the order in which they appear on the Action Centre, or free up 
screen space by removing those you don’t need – click ‘Add or 
remove quick actions’ to do so using a series of on/off switches.

5 Link in with your phone
You can share notifications between PCs and Windows 

phones and tablets, such as a low-battery warning. Cortana 
needs to be signed into your Microsoft Account on both devices 
– then open its settings (tap the ‘Search’ box on your PC and click 
‘Settings’). Make sure ‘Send notifications between devices’ is on, 
then tap ‘Edit sync settings’ to send and/or receive notifications.

8 Tweak notification settings
The main Notifications options are the same as those in 

the original Windows 10. Scroll to see all senders that can be 
configured to display notifications or not. Use the switches to 
enable or disable apps from using the Action Centre to notify you 
of updates, or click an app to reveal more granular settings.

6 Tweak Notification settings
If you right-click the Notifications button you’ll see there 

are two new options to go with ‘Turn on quiet hours’. ‘Don’t show 
app icons’ prevents an app icon briefly appearing when a 
notification appears from an app that doesn’t use toasts, while 
‘Don’t show number of new notifications’ prevents the 
Notifications button distracting you with an unread count.
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Priority levels
Notifications appear  
in three tiers: ‘top’ is 
assigned to a single 
app, while others  
are configured ‘high’  
or ‘normal’. 

resPoNse oPtioNs
Click a notification to 
access it through its 
app. Click the arrow to 
view it in detail or ‘x’ to 
dismiss it when read. see more

You can now view 
all  outstanding 
notifications for a 
selected app by 
clicking the ‘See 
more’ link. 

QuiCk ACtioNs
You can now rearrange 
all of your Quick Action 
buttons, not just those 
on the first row. 

9 Customise how apps notify you
You’ll see two new options when configuring individual 

apps’ notification settings. The first allows you to set the number 
of notifications displayed at once in the Action Centre – three is 
the default, but you can choose between one, three, five, 10 and 
20. The priority settings allow you to restrict which notifications 
appear – and where they appear in the Action Centre.

10 And finally...
There’s no doubt that the Action Centre and Notifications 

system in Windows 10 is much better than it’s ever been. One 
final improvement can be found when you click the time and 
date to the left of the Notifications button – you’ll see a list of all 
upcoming events from your calendar, as well as any reminders 
you’ve set through Cortana, which appear under the calendar. ■

CoNtrol 
NotifiCAtioNs
Switch off 
notifications for  
those apps, programs 
and services you  
find annoying. 

APP settiNgs
The quickest way to 
configure an individual 
app’s behaviour is to 
right-click it and 
choose ‘Go to 
notification settings’. 

Welcome to Windows 
Stay notified in Windows 10
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 new hardware   essential accessories   latest gadgets

even the owners 
of the most 
expensive new 
Pcs need to be 
aware that 

computer viruses are still 
out there and can wreak 
havoc on their systems. 
This issue we take four of 
the best antivirus programs 
for Windows and put them 
through their paces to find 
our favourite. They’re all 
free, so you have no excuse 
for not being protected! 
Also this issue, we look at 
the Amazon Echo Dot, 
which gives you all the 
power of the full Dot 
experience, but you need 
to bring your own speakers 
to the party. Enjoy, and I’ll 
see you next issue! 
 
Nick Odantzis Deputy Editor

Welcome

windowsmagazine@futurenet.com

The Upgrade section is your key to finding out about the latest 
products, all designed to help you get more from your PC

rating exPlained Superb GoodVery good Disappointing Poor

Our promise to you…

You can trust our reviews
Our reviewers are 100 per cent 
independent, with years of 

experience in the world of computing. 
Our rigorous testing procedures mean 
that only genuine, high-quality 
products are awarded high star ratings. 
If you see an item of hardware bearing 
a high score, you can be confident that 
it is an excellent product.

we choose the best products
Thousands of new PC products 
are released every year and 

choosing between them can be an 
impossible task. Our experts select only 
the best hardware and software to 
feature in this magazine. Even better, 
our star rating system makes it simple 
to find the best products, giving you  
a fast, trustworthy guide.

how we review
Our expert reviewers guarantee  
to test every piece of hardware 

rigorously and thoroughly, using  
only acknowledged experts to 
establish the worth of a product.  
We always review from the viewpoint 
of our readers; the day-to-day 
practicality and quality of a product  
is paramount.
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For the purposes of this review, 
it’ll be particularly easy to get 
straight to the point. Assuming 

you already own a speaker of 
some sort (and we’re thinking you 
already do), then you should buy 
the Amazon Echo Dot.

Our reservations about the 
full-size Amazon Echo (see our 
review in Issue 129), beautiful and 
full of promise though it is, were 
that it wasn’t amazing as a speaker 
for music, and it maybe felt a little 
over-priced. But, we’re pleased to 
say, there’s no way we could ever 
say the same about the much 
smaller Dot. 

Speaker cornered
Granted, its onboard speaker 
is barely audible, but, unlike 
the Echo, it has a line out (which 
is 3.5mm only, if you want to 
quibble), so you can plug it into 
whatever you like. We tried it out 
with a Denon Heos, a Naim Mu-so 
Qb and the much cheaper 

Marshall Kilburn and the 
improvement in sound quality and 
volume over the Echo was very 
very marked.

Smaller is better 
So, what is the Dot in comparison 
to its big sister, the Echo? Imagine 
the rotating portion of the 
full-sized Echo has been sawn 
off – that’s what the Echo Dot is 
like. It comes with a little speaker 
so the Alexa voice service, Amazon 
Echo’s AI hostess with the mostest, 
is able to reply to you when you 
need it to. 

In its most basic form, you 
could use a Dot as an extra 
portal for Alexa, in addition to 
an Echo. That would be a handy 
bonus to your already smart home. 
However, we wouldn’t particularly 
recommend that you listen to 
music through it. Use the 3.5mm 
output to plug in a decent-enough 
speaker, however, and the Dot 
instantly becomes just like 

the Echo, but with far superior 
sound quality. 

As such, it’s suitable for 
use anywhere in the house, 
meanwhile the Echo’s natural 
home is probably in the kitchen.

When you consider that this 
version of ‘Echo But With Better 
Sound Quality’ will cost you just a 
mere £50, it quickly becomes a 
must buy. Or if you don’t think it’s 
a must-buy, then at least it’s a 
you-might-as-well-buy…

 
Music Unlimited
The sheer affordability of Echo Dot 
(assuming you already own a 
speaker) makes it particularly easy 
to overlook a key fact. And that is 
other than playing music and 
serving as a kitchen timer and 
to-do list maker, Alexa doesn’t yet 
excel at much else.

However, the new Amazon 
Music Unlimited streaming app (or 
‘Skill’ to use the official Echo 
terminology) is undeniably 

Amazon Echo Dot
£50 | $50 www.amazon.co.uk

Alexa the voice-controlled PA for just 50 quid, and you can plug in your own speaker

88  |    |  February 2017



Final verdict
So, as you can guess, we’re fans 
of the Echo Dot. With a stellar 
selection of music on offer, as 
well as to-do list and timer apps, 
the Dot is a great device to have 
in the home. And then, on top of 
that, you have handy news, 
weather, smart home and calendar 
stuff too. 

Also, it’s compact and smart to 
look at. We like that you can 
plug it into any speaker with a line-
in. This will make it a versatile 
gadget around the home. It’s 
futuristic tech at an old-fashioned 
price. If you have an old, beloved 
but underused speaker, it’ll give it 
a new lease of life. To be honest, 
at this price, even if you don’t want 
to use Music Unlimited, the Echo 
Dot is still worth it. ■

A voice-controlled wonder for less 
than £50. If you own a speaker, 
buying this is all but obligatory.

fantastic. Spotify might not exactly 
be trembling with fear right now, 
not least because its app works 
very well on Echo too, but it 
should be a little concerned. 

With Echo, Music Unlimited 
gives you a whopping 40 million 
tunes for just £3.99 per month. 
That is a very good deal, indeed.

If you want to use it on your 
other devices it’s £7.99 or an 
extremely attractive £79 per year 
for Amazon Prime subscribers (this 

means the cost is on top of the 
usual £79 per year for Prime).

However, if you’re not a Prime 
user and want Music Unlimited 
on your mobile, then it’ll set 
you back a tenner. 

The great thing about Music 
Unlimited and the older, more 
limited, Amazon Prime service on 
Echo, is the particularly brilliant 
way it uses Alexa’s voice 
recognition and cloud database-
mining skills.

Tracks can be easily selected, 
favourited and skipped in all the 
usual ways you’re used to, but 
thanks to the miracle of metadata 

you can also ask it for “happy 
80s music” or “melancholic 
heavy metal” or even “sad Abba 
tunes from the 70s”. If you are 
that way inclined, that is.

Even more fabulously (in our 
opinion), you can actually ask 
for “That song that goes: [insert 
the relevant lyrics here]", with 
lyrics allegedly available for 
“70-something per cent” of the 
40 million tracks on offer. Try it 
for yourself, but try not to blame it 

when it doesn’t recognise your 
misheard lyrics…

Function
Functionally, the Dot is identical to 
the full-sized Echo, so when you 
add Alexa’s acknowledged skills 
(did we already mention this is 
what Amazon is calling its apps…) 
with timers, lists and turning your 
smart bulbs on and off, we’d say 
any music lover has more than got 
their money’s worth.

This really is AI on the cheap, 
with perhaps the ultimate music 
service also at a giveaway price. 
For us, it’s a done deal. 

“With a stellar selection of music, the Echo Dot 
 is a really great device to have in the home”
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Upgrade 
Amazon Echo Dot

KEY FEATURES

Amazon Echo Dot

Wi-Fi connectivity Dual-band  
Wi-Fi supports 802.11 a/b/g/n  
(2.4 and 5 GHz) networks. Does not 
support connection to ad-hoc (or peer-
to-peer) Wi-Fi networks
Bluetooth connectivity Advanced 
Audio Distribution Profile (A2DP) support 
for audio streaming from your mobile 
device to Echo Dot or from Echo Dot to 
your Bluetooth speaker. Audio/Video 
Remote Control Profile (AVRCP) for voice 
control of connected mobile devices. 
Hands-free voice control is not supported 
for Mac OS X devices. Bluetooth speakers 
requiring PIN codes are not supported
Audio Built-in speaker for voice feedback 
when not connected to external 
speakers. 3.5 mm stereo audio output for 
use with external speakers (audio cable 
not included)
System requirements Amazon Echo 
Dot comes ready to connect to your 
Wi-Fi. The Alexa App is compatible with 
Fire OS, Android and iOS devices and also 
accessible via your desktop browser. 
Certain skills and services are subject to 
change, may not be available outside the 
United Kingdom, and may require 
separate subscriptions or other fees
Included in the box Amazon Echo Dot, 
power adapter (9W), USB charging cable 
and Quick Start Guide 
Size 83.5 x 83.5 x 32mm 
Weight 163g



The EOS 750D is Canon’s key 
entry-level DSLR, but comes 
with a few more features 

designed to tempt slightly more 
experienced users.

In a first for Canon DSLRs, the 
750D features both Wi-Fi and NFC 
(Near Field Communication) 
technology to enable it to be 
connected to a smartphone or 
tablet for remote control and image 
sharing. It’s even possible to 
connect two cameras just by 
touching the NFC logos together, 
to transfer images wirelessly.

It has a 3.0-inch 1,040,000-dot 
Clear View II TFT screen that’s 
touch-sensitive. Plus, there’s 
an aspect ratio of 3:2 to match 
the uncropped ratio of the 
imaging sensor, while the vari-
angle hinge on the side of the body 
means it can be placed in a range 
of positions.

There’s also a 19-point phase-
detect AF system when shooting 
through the viewfinder. The choice 

of AF point can be left to the 
camera to decide in 19-point AF 
mode, or it can be set in Single 
point AF or Zone AF mode. In the 
latter mode you have the choice of 
five groups of points for selection, 
whereas in Single point mode all 19 
points are available for selection.

Build and handling
The 750D’s aluminium alloy and 
polycarbonate resin with glass-fibre 
chassis gives it a durable feel. And, 
reassuringly, it doesn’t creak when 
it’s gripped tightly.

Following the design of other 
Canon DSLRs, the 750D has a Quick 
menu that is accessed by pressing 
the Q button. This gives a quick 
route to some key features for 
adjustment. Setting adjustments 
can be made using the physical 
buttons and dials or by touching 
the screen. If you’re not used to 
using a touchscreen camera, you 
may find you start out using the 
buttons and dials, but gradually 

move over to using the touch-
screen, because it’s so intuitive.

Being a DSLR, the 750D has an 
optical viewfinder. Canon has used 
a pentamirror design that shows 
around 95% of the scene, so you 
need to take care with composition 
to avoid including unseen elements 
around the edges.

As the screen is on an articulating 
joint, it can be seen from a wide 
range of angles. Reflections are an 
issue in very bright light, but it is 
usually possible to see enough 
detail to compose images. In Live 
View mode it’s especially helpful to 
use the screen to set the AF point, 
or even set the AF point and trip 
the shutter when composing 
images at very awkward angles. 

The camera relies on an exposure 
compensation button. In manual 
exposure mode this button needs 
to be pressed while rotating the 
dial near the shutter release to set 
aperture, in the semi-automatic 
modes it’s used with the dial to 

Canon EOS 750D
£569 | $715 www.canon.com

One of the best entry-level DSLRs around
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the 700D to a whopping 940 Large/
Fine JPEGs or 8 raw files.

Viewed at 100% on-screen, the 
750D’s high-sensitivity JPEGs look 
softer than simultaneously 
captured raw files, but even at 
ISO12,800 some look good at 
around A3 size (16 x 12 inches). 

As usual, when all noise 
reduction is turned off, the raw files 
have more visible noise at 100%, 
but it’s fine grained and there’s no 
banding, so it’s possible to produce 
images that have a bit more ‘bite’ 
than the JPEGs.

Chroma noise is only obvious at 
100% in raw files captured at 
ISO1600 and above (when noise 
reduction is turned off). Meanwhile, 
the softening of detail that tends to 
go hand-in-hand with noise 
reduction in the default settings 
becomes apparent at 100% in 
JPEGs captured at ISO3200.

Verdict
The 750D can trace its heritage 
back to the early days of digital 
photography and it shows. A very 
polished and well thought-out 
camera, the 750D is a great intro to 
DSLR photography for those 
looking to make the step up from a 
compact or smartphone. ■

Capable of superb image quality, 
with the touchscreen interface 
making it much quicker to use.

adjust exposure compensation. It’s 
a quick and easy task, but the Quick 
Control dial on the 760D makes 
these adjustments a little faster.

The exposure mode is set using 
the dedicated dial on the right of 
the top-plate. There’s no lock on 
the dial, but it doesn’t get knocked 
out of position easily and it 
provides a route to the same 
exposure modes including 
program, shutter priority, aperture 
priority and manual, as well as 
options such as Full Automatic 
(Scene Intelligent Auto), Creative 
Auto (which allows you to take 
control with simple instructions 

using non-photographic terms) and 
a collection of user-selectable 
scene modes, including some 
within Special Scene (SCN) mode.

Autofocus
Pressing the AF Area selection 
button once allows the navigation 
buttons to be used to set the 
desired AF point. Pressing it 
multiple times toggles through the 
AF-point selection modes (Single-
point AF, Zone AF and 19-Point 
automatic selection AF). There’s 
also an AF point selection button, 
but this doesn’t allow you to toggle 
through the modes. It would be 
nice to be able to set the AF point 

on the screen while composing 
images in the viewfinder as you can 
with some Panasonic cameras and 
the Nikon D5500.

The phase-detection AF system 
that’s available when composing 
images in the viewfinder is fast and 
accurate, even in quite low light 
with the kit lens mounted. It means 
it’s a much better choice when 
shooting sport or action. In 
19-point mode it does a pretty 
good job of identifying the subject, 
but Zone-AF and Single-point 
mode are a better choice, provided 
you can keep the active area over 
the right part of the scene.

When using Live View mode we 
found the 750D can get subjects 
sharp quickly, so it’s possible to 
compose images on the main 
screen when hand-holding the 
camera. However, it’s not really fast 
enough to use it to shoot moving 
subjects, and there’s no servo 
option, so it can’t adjust focus as 
subject distance changes when 
your finger is on the shutter release.

The 750D can also shoot 
continuously at up to 5fps. This may 
not seem fantastic by current 
standards, but it’s still very useful 
when shooting sport. Plus, the 
burst depth has been increased 
from the 30 JPEG or 6 raw files of 

“Connect two cameras by touching the NFC  
logos together to transfer images wirelessly”
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Upgrade 
Canon EOS 750D

KEY FEATURES

Canon EOS 750D
Image sensor 22.3 x 14.9mm CMOS
Focal length Equivalent to 1.6x the focal 
length of the lens
Shutter speed 30-1/4000 sec (1/2 or 1/3 
stop increments), Bulb (Total shutter 
speed range. Available range varies by 
shooting mode)
LCD monitor Touchscreen vari angle 
7.7cm (3.0") 3:2 Clear View II TFT, approx. 
1040K dots
Storage SD, SDHC or SDXC (UHS-I)card 
Battery 1 x Rechargeable Li-ion Battery 
LP-E17 
Dimensions 131.9 x 100.7 x 77.8mm
Weight (body only) 555g (including 
battery and memory card)



When it comes to wireless 
gaming headset, 
then these are an 

excellent, top-of-the-range choice. 
And, if this sounds like something 
you’re in the market for, then you 
can stop reading this right now, 
head on over to your retailer of 
choice, and pick up this gadget 
– you will not be disappointed.

You get Dolby® Headphone 7.1 
surround sound with built-in 
MixAmp™ technology, a 5GHz 
low-latency wireless connection 
over 30 feet, 15 hours of Lithium-
Ion battery life on a single charge, 
a pro-grade microphone with 
flip-up mute and and headset 
with three distinct EQ profiles 
that can be added to or tweaked 
with Astro’s bundled software.

In other words, you get a lot 
of bells and whistles in the Astro 
A50 Wireless + Base Station box 
(which for the money requested, 
you certainly should do).  

The A50s come in a black-and-
blue colour scheme for PS4 
compatibility or grey and green for 
Xbox One compatibility (both sets 
also work with PC and Mac). They 
also come in a large black box. Slide 
off the outside sleeve of said box, 
and you are presented with (yep, 
you guessed it) another black box.  
However, this one opens down the 
centre and is decorated with a 
cool-looking robot.

With the inner boxed now 
opened (are you still with us?) you 
are finally presented with the A50 
headphones themselves, which are 
securely nestled in a moulded 
plastic inner. Also embedded in the 
inner are digital audio and 
USB-to-micro-USB cables, which are 
required to transfer audio data and 
power from your console or 
computer to the Base Station.

Underneath the plastic inner is 
the Base Station itself, which is a 
cool, black slab of thing indented at 

the top with a recess for depositing 
the headphones in when they are 
not in use.

Within this recess lies a brace of 
small-scale power prongs which, 
when the headphones are slotted 
in, make contact with small 
receptive power plates on the 
bottom of one of the headset’s ear 
cups, thereby charging them for 
wireless operation.

Back to Base
Sticking with the Base Station, on 
its front lies a number of indicator 
lights, highlighting things such as 
power and charge level, while at its 
rear lies a brace of digital optical 
ports (one for in and one for out), a 
micro USB port and an AUX out.

As such, not only can you 
connect the Base Station to your 
console or computer of choice, but 
you can also bring in sources from 
elsewhere too, overlaying music 
from a phone, for example, while 
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A50 Wireless + Base Station

£250 | $300 www.astrogaming.co.uk
Astro ups its game with this fantastically mature and powerful headset



seems on the money at around the 
15-hour mark. Charge the A50s to 
full power – indicated by four 
power bars on the front of the Base 
Station – and you can forget about 
having to charge them for quite a 
while, which in our case sometimes 
stretched out over a week.

That ability to just pick up and 
play, without frequently being met 
with low-battery warning beeps, 
was most welcome.

Verdict
Overall then, we had a great 
experience with the Astro A50 
Wireless + Base Station. Everything 
about this gaming audio system 
just screams premium – well, 
everything but the fabric ear-
cushions and headband cushion 
(which can be upgraded to 
synthetic leather) – and we were 
impressed with its commitment to 
kill compromise across the board.

Factors such as the fabric 
ear-cushions, and the price, stop it 
from landing a perfect-5 score-
wise, but we have no problem 
otherwise recommending the 
Astro A50 Wireless + Base Station 
if you are on the market for a 
premium gaming headset. ■

This gadget offers some game-
changing performance and  
style that is hard to ignore.

gaming. You can also feed the 
gaming audio, voice included, into 
another system for capture.

The headset itself is an over-ear 
thing of industrial, futurist beauty. 
Chrome, perforated, hollow 
tubes extend from the chunky, 
rubberised-finish earcups up to 
a robust, cushioned headrest, 
joining them together in a 
wide profile.

On the earcups themselves lie a 
small quantity of buttons, switches 
and dials, which handle things like 
power, profiles and volume, as well 

as the headset’s raise-to-mute 
microphone, which is positioned on 
exterior of the left cup. In a nice 
touch, all the switches are 
positioned at the rear of the 
right-hand cup, hiding them from 
view, while also making them easily 
accessible while gaming.

Once the Base Station is 
connected to your system of 
choice, operation is then as easy as 
simply lifting the A50 from the 
dock, flicking the power switch, and 
placing the cans over your ears. 
Then, aside from selecting an EQ 

profile by sliding a switch to one of 
three different positions, you are 
good to go.

Audio quality is, as you would 
expect from a gaming headset, 
inclined slightly toward the 
low-end, with absolutely cracking 
distortion-free bass, while the 
immersive surround sound is 
absolutely superb. In addition, the 
headset fits just as snugly if you are 
using PlayStation VR. The volume 
range is also excellent.

Connectivity range, providing 
you don’t put thick stone walls 

between you and the Base Station, 
is also pleasingly large and secure. 
You can walk around, sit, perch, loll, 
balance, jog or whatever else takes 
your fancy around the Base Station 
and, from our testing at least, not 
experience any distortion or 
dropouts. Having the Astro A50s 
operating on a frequency north of 
5GHz clearly does have its 
advantages after all.

Power up
Battery life too, despite us not 
sitting there with a stopwatch, also 

“Connect to your console or PC, or bring in sources 
from elsewhere too, music from a phone, for example”
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Upgrade 
Astro Gaming A50 Wireless + Base Station

KEY FEATURES

Astro Gaming A50 Wireless 
+ Base Station
Frequency response 20Hz - 20,000Hz
Characteristic SPL 118dB @1kHz
Processor microphone 6.0mm 
unidirectional noise canceling
Nominal impedance 48 ohms
Power supply USB Micro-B  
(USB 2.0 compatible)
Ear coupling Over-Ear
Weight without cable 0.83 lbs (380g) 
Wireless Up to 30ft 
Drivers 40mm Neodymium Magnet 
Base Station inputs and outputs 
Optical pass-through, USB power & 
soundcard, USB charging port, AUX In / 
Mic out (TRRS 3.5mm)
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Which is the best  
free antivirus 

app?
Top-quality antivirus doesn’t have to cost a penny –  

here are four great options

 Every PC that’s connected 
to the internet needs 
antivirus software, but 
that doesn’t mean you 

have to pay for it. Many of the 
biggest developers of premium 
security software also offer free 
antivirus software that offers 
excellent protection from 
online threats. 

We’ve used the findings 
of expert virus lab AV-TEST  
(www.av-test.org) to evaluate 
the true effectiveness of their 
virus protection, but that’s  
only half the story. Your  
free antivirus software has to 

be running all the time, and if it 
annoys you with pop-up 
notifications or hits your system 
resources too hard, you’ll soon 
become frustrated.

With all this in mind, we’ve 
collected four of the best free 
antivirus programs for your  
PC. So, let’s see which titles 
float our boat. Oh, and 
remember never run more  
than one antivirus app on  
your PC at once – like a  
guard dog, they can be  
great at scaring intruders,  
but they don’t always play  
well with others.

The best 
fireWall  
app for  
your pc
See next issue,  

details page 98

Software Test
Free antivirus apps
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Avira Free Antivirus took the top 
spot on our previous free antivirus 
roundup, and here it is again. Yes, 
AV-TEST’s results show it to have a 
micron less protection than the 
likes of AVG, but it’s the slickest, 
cleanest and least system-
intensive antivirus package going. 

1 Avira Free Antivirus
www.avira.com

RATING

It’s almost as if the programmers 
sat down to determine what users 
would want out of an antivirus 
package and somehow stumbled 
on the correct answer: something 
that isn’t in your face every two 
seconds and doesn’t slow your PC 
to a halt just by existing.

So hooray for Avira. It doesn’t 
even install a host of other 
packages (including a secure 
browser, VPN and safesearch 
plugin) by default, although 
they’re there if you want them.

It’s not the glossiest package, 
and the install process is a bit 
pre-emptive, with Windows 10 
repeatedly shouting at us to 
update Avira before it had even 
finished making its way onto our 
test machine, but we’re inclined to 
blame Microsoft for the latter 
glitch. Overall, Avira Free Antivirus 
is brilliant, and is our pick for this 
year’s best free antivirus software.

2 AVG AntiVirus Free
www.avg.com

RATING

Even though AVG Antivirus Free’s 
virus protection is wrapped in AVG 
Zen – essentially a large advert 
designed to encourage you to 
install all of AVG’s products on all 
the PCs in your home – we won’t 
hesitate to recommend it.

AV-TEST gave AVG AntiVirus a 
100% rating for its protection 
against zero-day attacks during its 
May-June 2016 testing, for a start. 
It’s reasonably quick to scan after 
the first initial pass, and the 
interface – ignoring the Zen bit of 

it – is clear and easy to use. 
Combine it with the mobile app 
and you can set it to scan and 
disinfect a machine without 
having to be close to it, which is a 
feature you won’t know you need 
until it’s too late.

There are a few downsides. For 
example, we’re not that fond of 
the level of permissions that 
AVG’s Web TuneUp extension asks 
for – everything from ‘read and 
change all your data on the 
websites you visit’ to forcing your 
start page to AVG’s own Yahoo-
powered search engine – but 
that’s an optional component.

Fast, effective  
and discreet – 
Avira is the  
best free antivirus 
software available.

Superb free 
antivirus with  
a clear interface, 
AVG is a great 
choice for your 
whole home.

Winner!
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Although Panda Free Antivirus 
claims to be the world’s lightest 
antivirus – offloading much of 
the processing work that 
would normally be done by your 
PC to the cloud – we found it to 
be slightly slower than Avira in 

3 Panda Free Antivirus
www.pandasecurity.com/uk/homeusers/solutions/free-antivirus 

our tests, and AV-TEST agreed. 
It’s also right on the industry 
average in terms of virus 
detection, sitting at around the 
98% mark for zero-day attacks 
and a hair under 100% for 
established threats.

Those are good numbers, and 
Panda is good free antivirus 
software – as long as you 
remember to deny it permission 
to hijack your browser’s home 
page and search facility upon 
installing. Its process monitor is 
very useful, it scans quite quickly, 
and it’s simple enough in its 
presentation for even the most 
technophobic user to find their 
way around. Switch on its 
automatic USB vaccination to 
ensure you won’t get a nasty 
infection when you insert 
something you shouldn’t into one 
of your ports.

This is among the hardest-nosed 
free antivirus packages out there, 
built as it is from Comodo’s 
serious systems administration 
background. Comodo Free 
Antivirus features a ‘default deny’ 
mode, which essentially blocks 
every single program that’s not on 
its whitelist – if you let something 

4 Comodo Free Antivirus
https://antivirus.comodo.com

RATING

through and your machine 
becomes infected, it’s going to be 
your fault.

There’s cloud scanning, so 
it theoretically keeps up with 
the latest found threats and 
automatically updates all users 
based on the newest discoveries. 
And, indeed, Comodo scored a 

perfect 100% against AV-TEST’s 
barrage of zero-day threats, but its 
historical protection lags behind 
somewhat at just over 97%.

While Comodo’s free antivirus 
software has a sharp design all 
of its own, we’d also say it’s also 
something of a mess, unleashing 
window upon window on your 
machine and not really shutting 
up and giving you any peace.

You certainly know when you 
have it installed. At least it 
includes a game mode, 
automatically dialling back on its 
actions when you need maximum 
performance from your machine.

RATING
Free antivirus  
that uses the 
power of the cloud 
to take the load off 
your computer.

Serious free 
security software 
for Windows, 
Comodo Free 
Antivirus pulls  
no punches.

Software Test
Free antivirus apps
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Get rid of junk files for a 
faster, more efficient and 
reliable PC

spring 
clean 
your pc 
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